
 
 
 

Getting Started  

Welcome to the new launch pad for your digital universe. From this single application window you can 
perform a vast array of disc recording projects that once might have required a dozen or more separate 
software applications.  

Click on any of the links below to get started:  

� The application window 

� How projects work 

� Working on more than one project at a time 

� Saving a project 
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System requirements  

The project launcher has the following system requirements:  

� Operating system support: 

� Windows 2000 with Service Pack 4 

� Windows XP Home Edition 

� Windows XP Professional Edition 

� Windows XP Media Center Edition 2005 

� Windows XP 64-Bit Edition 

� Windows Media Player 9 or greater to: 

� obtain built-in audio playback support. 

� Hard drive with at least 40 MB of free space for installation (at least 700 MB of free space is 
recommended for storing temporary files) 

� 128 MB RAM, or more (256MB or more for double-byte language systems) 

� Internet Explorer 5.0 or greater with JavaScript enabled for reading Help and Tutorial files 

� A CD or DVD recorder equipped with BURN-Proof technology. Click here to connect to the 
Sonic Web site where you can view a complete list of supported drives. 

� For 8x speed recorders, or slower: 

� 150 MHz processor, or faster  

� Bus-mastering EIDE controller 

� DMA enabled on the hard drive 

� For 10x speed recorders, or faster: 

� 300 MHz or faster processor 

� Bus-mastering EIDE controller 

� DMA enabled on the hard drive 

Page 1 of 95Getting Started

6/29/2006file://C:\Documents and Settings\dpsuser\Local Settings\Temp\~hh412D.htm



Note: Some project plug-ins have additional system requirements. These requirements are listed in 
the Help section that describes each plug-in.  
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Starting the application  

To start the project launcher:  

� Select the project launcher from the program list available on your Windows Start menu. If it 
was installed as part of a Sonic media suite, select the name of the media suite. 

or  

� Click on the program icon on your desktop, if you elected to create one during program 
installation. 
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Getting help  

There are several places you can turn for answers to your questions. The most complete source of 
information is this Help file. It explains how to use the project launcher and all of the project modules 
installed on your computer. It contains a table of contents and an extensive index. The Help file also 
includes a Search tab that can display a list of topics containing the words you select.  

The Help file grows along with you. Whenever you add a new project module, new Help topics about that 
module are automatically added. If you uninstall a module, the Help topics for that module are also 
removed.  

  To open the online Help:  

� Choose Help from the Help menu. 

� Press the F1 key on your keyboard any time the project launcher is the active program on your 
computer screen. 

� Click on the Help button  found on many project windows. A Help topic about that project 
will open. 

Other Sources of Help  

� Tutorial — An interactive tutorial is included to help you start burning discs like a pro. It can be 

accessed from the Help menu or by clicking on the Tutorial button  located throughout the 
application. 

� Extended Pop-up Help — Hold your mouse cursor over almost any feature and a small text 
window will open explaining the purpose of that feature.  
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� Explain Buttons — Click on any of these buttons to open a Help topic that explains the feature 
you are using in more detail. 

� Technical Support on the Web — If you have an Internet connection, this selection on the Help 
menu will take you to Sonic's technical support site, where you will find answers to frequently 
asked questions, additional product information, and technical support. 

� Associated Programs — Some projects are performed by software that is started from within the 
project launcher. In many cases, these associated programs have their own Help files with 
additional information about the project you are performing. 

Note: The technical support link is not available on all versions of this product.  
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Accessibility  

Program functions can be accessed from the keyboard without using a mouse. Standard Microsoft 
navigation techniques and keyboard shortcuts are used.  

Navigation  

Screen navigation from the keyboard is typically achieved using the Tab key to move from function to 
function, the arrow keys to select options within a function, and the Enter key to activate your selection.  

The current active area of the screen is enclosed with a rectangle formed by dotted lines. Pressing the 
Tab key moves the rectangle to the next active area.  

Tip: Holding down the Shift key and pressing the Tab key reverses the tabbing order, making it 
easy to return to the last active area of the screen.  

Keyboard shortcuts  

A standard system of accelerator or "hot" keys provides keyboard access to many program functions.  

  To activate a program function from the keyboard:  

1. Begin by noting that all function names and all program options have a single letter underlined. If 
the underlines are not visible, press the Alt key. 

2. Hold down the Alt key and press the letter on the keyboard that is underlined in the item you 
wish to access.  

The following table lists some frequently uses keyboard shortcuts: 

Frequently used keyboard shortcuts  

To do this ...  Press these keys ...  

Page 3 of 95Getting Started

6/29/2006file://C:\Documents and Settings\dpsuser\Local Settings\Temp\~hh412D.htm



© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Removing the application  

The project launcher is automatically removed from your computer when the last of your project plug-ins 
is removed.  

  To remove the project launcher:  

� Use the Add or Remove Programs option available in the Windows Control Panel to remove 
each of your project plug-ins. (In some operating systems, this feature is called Add/Remove 
Programs.) The main application is automatically removed when the last of your project plug-ins 
is removed. 

For additional information on removing programs from your computer, please see your Windows 
documentation.  
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Using the project launcher  

The following topics describe the project launcher in detail:  

� The application window 

� How projects work 

� Working on more than one project at a time 

� Using the project panel 

� Using the mini-UI 

� Options 

� Using double-layer discs 

� Troubleshooting advice and error messages 

Cancel a project or 
operation  

Esc  

Open Help  F1  

Duplicate a mouse click  Use the Tab and arrow keys to reach the desired function or menu item 
then press Enter.  

Duplicate a right-click of 
the mouse  

Use the Tab and arrow keys to reach the desired program function or 
menu item then press Shift + F10.  

Open the Start menu  Windows logo key  

Open Windows Explorer  Windows logo key + E  
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The application window  

The application window is divided into four main areas:  

� The menu bar — Most major program operations can be accessed through one of the three 
menus: File, Tools, and Help. Most menu items have keyboard shortcuts. The menus are 
dynamic may grow when new project plug-ins are added. See The menu bar explained for more 
information. 

 

  

Menu bar  

� The project list — On the left side of the application window is a set of tabs. Each tab represents 
a project category. Click on a tab, and all of the available projects in that category are displayed. 
Click on a project name to start the project. See Starting a new project for more information. 

 

  

Project list  

� The project window — This is the largest portion of the application window. This is where you 
will perform most of the steps necessary to complete your projects. The work area is also used 
to display welcome messages, Web pages, and other useful information. 
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Project window  

� The control panel — The control panel stretches across the bottom of the application window. It 
consists of three main areas: the media information display on the left, the input panel in the 
center, and the action area on the right. See The control panel explained. 

 

  

Control panel  
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The menu bar explained  

The menu bar extends across the top of the application window and includes three menu categories: File, 
Tools, and Help. This topic describes the basic set of menu items. New menu items may appear as you 
add new project plug-ins.  

  

Menu bar  

File Menu  

� New Project — Starts the new project you select. 

� Open — Opens a saved project. More than one project can be open at a time, but they must be 
different types of projects. 

� Save — Saves the current project. If the project cannot be saved, this menu item will be not be 
available. See Saving a project for more information. 

� Save As — Prompts you to save the current project under a new name. Save As is useful when 
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you want to create variations of an existing project without affecting the original. If the project 
cannot be saved, this menu item will be not be available. 

� Recent Saved Projects — Lists the last 10 saved projects. Select a project from the list to open 
it. 

� Exit — Closes the project launcher. If any of your unsaved projects can be saved, you will be 
prompted to save them. 

Tools Menu  

� Eject/Close Drive Tray — Opens or closes the drive tray. The menu will include an entry for 
each drive attached to your system. (This feature does not work with all drives.) 

� Erase Disc... — Opens the Erase Disc project. See Erase Disc for more information. (Selecting 
this menu item does not immediately erase a disc.) 

� Finalize Disc... — Opens the Finalize Disc project. See Finalize Disc for more information. 
(Selecting this menu item does not immediately finalize a disc.) 

� Disc Information... — Displays information about the selected disc and its contents. See Disc 
Information for more information. 

� Label Disc... — Opens the Sonic disc labeling application if it is detected on your computer. See 
Label Disc for more information. 

� Options... — Opens the Options panel, which can be used to customize the main application 
and any installed project plug-ins. See Options for more information. 

Help Menu  

� Help — Opens the Help file, which explains how to use the main application and any project 
modules installed on your computer. 

� Tutorial — Opens the Tutorial, with topics describing how to use the launcher and how to 
complete most major projects. 

� Register Now... — If you have an Internet connection, this menu item will open a Web site 
where you can register your program. Registration may be necessary to obtain technical 
support. 

� Technical Support on the Web — If you have an Internet connection, this menu item will take 
you to a technical support site, where you will find answers to frequently asked questions, 
additional product information, and technical support. 

� Sonic Store — Obtain program upgrades, buy labels, and explore the full line of award-winning 
Sonic products at Sonic's on-line store. 

� Check for Updates... — Use this menu item to check for new versions of the main application 
and any project modules you have installed. 

� About This Software — Selecting this menu item displays a window containing version numbers 
and other information about the main application and each of your installed modules. 

Note: Some of the menu items described here may not be available with this version of the 
program.  
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The control panel explained  
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The control panel stretches across the bottom of the application window. It consists of three main areas: 
the media information display on the left, the input panel in the center, and the action area on the right.  

  

Control panel  

Media information display  

This display includes a visual representation of the disc or hard drive that is the destination for your 
project. The information presented varies from project to project and is updated when you change discs 
or destination drives.  

  

The media information display  

Some of the information you will see here includes:  

� The format and capacity of the disc currently inserted in your recorder drive 

� The volume label or title of the disc 

� The free space remaining on the disc. 

� The number of the discs needed to complete the current project 

For best results, insert a blank or appendable disc into your recorder drive before starting your project. If 
no disc is detected or if the disc in the drive is incompatible with the project (a DVD disc for a CD-only 
project, for instance), the estimates shown will be based on the type of disc most commonly used for your 
project.  

  

The arrow shows the progress indicator moving around the disc.  

Input area  

The input area in the center of the control panel changes from project to project and in some cases, from 
step to step within a single project.  
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Input area with drive drop-down menu  

The input area is used to display:  

� A drop-down menu you can use to select the recorder drive for the active project. In some 
projects, this same drop-down menu can be used to browse to a specific file or location on your 
hard drive. 

� The progress of the active project. 

� Audio and video playback controls. 

Action area  

On the right side of the control panel is the action area where you will set many projects in motion by 
clicking an action button. The action button only appears when a project has been selected.  

  

Action area  

Tip: To cancel a project after you have clicked on the action button, click on the action button again.  
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Adjusting the size of the project launcher on the screen  

To resize the application window:  

� Click on any edge of the project launcher and drag with your mouse. 

� Click on the Minimize button  to minimize the application on the Windows taskbar. Click on 
the application name on the taskbar to restore the program to its previous size. 

� Click on the Maximize button  to have the application window fill your computer screen. The 

Maximize button changes to a Restore Down button. Click on the Restore Down button  to 
restore the program to its previous size. 

� Click on the Switch button to switch to a miniature version of the user interface, referred to 
throughout this Help file as the mini-UI. See Using the mini-UI, for more information. 
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The Switch button  
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Using the mini-UI  

Two versions of the project launcher interface are available: the full-size application window and a 
miniature version that is referred to throughout this Help file as the mini-UI.  

The mini-UI offers a subset of the features available in the full-size interface. This help topic describes its 
basic features. To learn more about completing a project with the mini-UI, consult the Help section for the 
type of project you wish to complete.  

  To open the mini-UI:  

� Click on the Switch button located in the upper right-hand corner of the full-size application 
window. The mini-UI is displayed. 

 

  

The Switch button  

Two views of the mini-UI  

  

Feature  Function  
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How projects work  

Most projects follow a basic three-step process:  

1. Select a project from the project list. 

2. Follow the instructions in the project window. 

3. Click on the action button. 

Select one of the links below for more details:  

� Starting a new project 

� Canceling a project 

� Saving a project 

� Opening a saved project 

� Working on more than one project at a time 
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Starting a new project  

  
Click on this button to open the Options panel.  

  
Click here to access the audio playback controls. The Audio Playback window is shown in the 
lower view.  

  
Clicking on one of the project icons opens a miniature project window tailored to that project.  

  
Click here to close the application.  

  
Click here to browse for files on your computer.  

  
Click on this icon to change projects.  

  
Click here to open the full-size version of the application window.  

  
Click here to minimize the application to the Windows taskbar.  

  
Click here to open the Help file.  
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You can start a new project using any of the following methods:  

� Choose File > New Project, then choose a project from one of the submenus. 

or  

� Click on a project tab in the project list. A list of projects appears. Click on a project name to 
start a new project of that type. 

or  

� Click on a project tab in the project list. If a project guide is listed, click on it. Descriptions of all 
the projects on that tab are listed in the project window. Click on one of these descriptions to 
start a project of that type. 

or  

� Click on the New Project button to save or cancel the current project and start a new project of 
the same type. 

Note: A project guide may not be available on every project tab.  

Other topics:  

� Canceling a project 

� Saving a project 

� Opening a saved project 

� Working on more than one project at a time 
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Canceling a project  

Occasionally you may wish to cancel a project or simply start over. To cancel a project before clicking the 
action button, do one of the following:  

� Select a new project from the File menu. If you are asked if you would like to save the current 
project, click on the No button. 

� Select a new project from the project list. If you are asked if you would like to save the current 
project, click on the No button. 

� Click on the New Project button. If you are asked if you would like to save the current project, 
click on the No button. 

To cancel a project after clicking the action button, click on the action button again.  

Other topics:  

� Starting a new project 

� Saving a project 

� Opening a saved project 

� Working on more than one project at a time 
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Saving a project  

Many types of projects can be saved. The application doesn't actually save copies of all the files in a 
project; it saves the list of files and their location on your computer. This makes it easy to recreate a 
project in the future.  

  To save a project:  

� Choose File > Save. (If Save is inactive, the project is a type that cannot be saved.) 

or  

� Click on the Save button in the lower left corner of the project window. 

Note: When you open a saved project, you will be notified if any of the files in the project are 
missing. This can happen if a file is moved or deleted after a project is saved. To restore a missing 
file, add the file again from its new location.  

Other topics:  

� Starting a new project 

� Canceling a project 

� Opening a saved project 

� Working on more than one project at a time 
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Opening a saved project  

By default, saved projects are stored in your My Documents folder with a .sonic file name extension.  

  To open a saved project:  

� Choose File > Open. Use the window to navigate to the file. Select the file and click on the 
Open button. 

or  

� From the File menu, select a project from the list of recently saved projects. 

or  

� Using Windows Explorer, navigate to the saved project file. Double-click on the file name, and 
the project will open. 

Note: When you open a saved project, you will be notified if any of the files in the project are 
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missing. This can happen if a file is moved or deleted after a project is saved. To restore a missing 
file, add the file to the project window from its new location.  

Other topics:  

� Starting a new project 

� Canceling a project 

� Saving a project 

� Working on more than one project at a time 
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Working on more than one project at a time  

You can set up and record more than one project at a time with the following limitations:  

� Two projects of the same type cannot be open at the same time. 

� Some versions of the program limit the number of projects that can be open at the same time. 
You will be notified if you attempt to exceed this limit. 

  To work on more than one project at a time:  

1. Open the first project. See Starting a new project for more information. 

2. Complete as much of the first project as you wish. 

3. Select a second project from the project list. 

The second project opens in the project window, and all your work on the first project is 
maintained.  

4. Complete as much of the second project as you wish. 

5. To return to the first project, click on the appropriate project tab and then click on the name of 
the project type that corresponds to the first project. 

Tip: Fast User Switching in Windows XP is supported. This means more than one computer user 
can complete projects at the same time. However, the program's progress indicators only display 
the progress of the current user's projects.  
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Following your progress  

The progress of the active project is displayed in the control panel.  
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Project progress displayed in the control panel  

The progress of projects running in the background are moved to the project list.  

  

Project progress displayed in the project list  

Note: Only one progress bar can be displayed on each project tab. If two projects on the same tab 
are running simultaneously, the progress bar will display the progress of the project started first.  

Other topics:  

� Starting a new project 

� Canceling a project 

� Saving a project 

� Opening a saved project 
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Using the project panel  

Some projects include a retractable panel that supplements the main project window. The panel name 
varies from project to project. An example of the panel is shown below. The button used to open and 
close the panel is circled in red.  
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Project panel with open/close button circled  

Note: Help topics describing individual projects that use a project panel describe this feature in 
more detail.  
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Options  

Click on the Options button  on the control panel to open the Options window. Here you will find 
settings that can be used to customize your projects.  

Each available group of options is displayed in the left-hand pane. Click on the name of an options group, 
and those option settings appear on the right.  

Options that apply to the entire application are grouped on the General options panels. New options 
become available as you install new project plug-ins. To learn more about the options for an installed 
plug-in, open the section of the Help file that explains the features of that plug-in.  

Each panel includes a Restore Defaults button that can be used to restore the default settings for the 
options on that panel only.  

Note: Not all options are available for all drives or operating systems. The Advanced options 
panels are not available on all versions of the application.  
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Other topics:  

� General options 
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General options  

Use the General panel to customize the following settings:  

Startup  

� Check for updates: If the Update Manager is installed on your system, this option will check to 
see if a newer version of the application is available. 

Exit  

� Prompt to save projects when exiting application: Each time you exit the application, you will 
be reminded to save any unsaved projects. If you do not wish to be reminded to save your 
projects, remove the check mark from this option. 

General options — Advanced panel  

Use the Advanced panel to customize the following settings:  

� Disable system autorun: The Windows autorun feature can be an annoyance. Select this 
option to disable autorun when using this application. 

� Overburn by (sectors): Overburn is a technique some CD recorder manufacturers use to 
squeeze a bit more data onto a CD-R disc. Set the desired amount to be overburned by typing 
the number into the Overburn by (sectors): textbox. 

Caution: Overburning a disc can cause recording errors and problems reading the disc in 
CD-ROM and DVD-ROM drives.  

� Recording memory cache: The default is 4.7 MB. In most cases, you do not need to change 
this setting. Increasing the cache can help prevent underrun problems, but only on computers 
with 512 MB or more of RAM.  

� Select drive speed: Depending on your system, one or two drop-down lists allow you to 
manually set the recording speed for your CD and DVD recordings. The available speed settings 
are based on the information reported by your recorder drives. 

By default your recordings will be burned at the maximum speed available for your combination 
of drive and media. If you experience errors during recording, try reducing the maximum 
recorder speed.  
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Using double-layer discs  

Double-layer discs are supported when used with compatible DVD recorders.  

Double-layer discs have two reflective surfaces, one slightly beneath the other. The DVD player's laser 
reads one surface from the disc center to the edge, then refocuses on the other surface and reads back 
toward the center. Unlike double-sided discs, you do not need to turn the disc over during recording or 
playback. There is a small pause in playback when the laser refocuses, but this is usually not noticeable.  

Here are some tips when using double-layer discs with this application:  

� Double-layer discs are also called DVD 9 discs. 

� Double-layer DVD discs can only be copied to other double-layer DVD discs. Similarly, single-
layer DVD discs must be copied to single-layer DVD discs. 

� When using with double-layer +R media in a double-layer +RW drive, a message is displayed 
containing important information about the use of appendable double-layer discs. 
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Troubleshooting advice and error messages  

The following topics provide troubleshooting advice to help you solve the most common issues when 
recording discs:  

� Burn failures 

� Plug-and-play support 

� Error occurred while reading from the source disc 

� Buffer underrun error 

� Error while copying a disc 

� Optical recorder drives in use by other applications 

� Missing or wrong type of files 

� Scanning for music files 

� Recording error 

� Not enough space on the disc 

� Not enough space on the hard drive 

� Testing issues with the disc 

� An error occurred while verifying files 

� Displaying audio information 
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Burn failures  
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If your recording fails or if some files could not be recorded, you will be notified in the project window.  

Recording errors often occur when the media contains dirt, fingerprints, or scratches. In some projects, 
files may not be recorded because they were in use by another application while the project was running.  

If you are getting recording errors:  

� Make sure the format and speed rating of the disc you are using is compatible with your disc 
recorder. 

� Try using a different manufacturer's disc.  

� Ensure the disc is clean before recording:  

� Remove all fingerprints, dirt, and dust from the shiny side of your disc using a 
nonabrasive cloth with a mild, nonabrasive soap solution. 

� Wipe the disc from the center to the edge.  

� Dry the disc completely.  

� Close other applications running on your computer while recording. 

Note: If you still experience recording errors after trying these suggestions, refer to your 
recorder's User Guide for more information.  

Viewing error messages  

The burn failure window can display an error message that may help you determine the cause of the 
problem. To view the error message, click on the Advanced button.  
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Plug-and-play support  

It's not necessary to have a disc recorder connected to your computer to use this product. You can set up 
and save projects, launch companion products, and even complete some projects without a recorder.  

You can also add or remove drives while projects are open. Here are some tips that will help you:  

� If the currently selected drive is removed, the application will automatically choose the next 
available drive. If no other drive can be found, the drive selection menu will display No drive 
detected. 

� If you add a CD or DVD drive to your computer, it will be available for use by the project 
launcher unless you are in the middle of burning a disc. In that case, the new drive will not be 
available until you are finished burning the disc. 
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Error occurred while reading from the source disc  
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If your source disc is scratched or dirty, your disc reader may not be able to read the media. Try the 
following actions to solve the problem:  

Cleaning the disc  

1. Remove all fingerprints, dirt, and dust from the shiny side of your disc using a nonabrasive cloth 
with a mild, nonabrasive soap solution. 

2. Wipe the disc from the center to the edge of the disc.  

3. Dry the disc completely.  

Try using a different source drive  

1. To change the drive you use to read your disc, click the drive drop-down menu in the project 
window. 

2. Select the drive you wish to use from the drop-down menu. 

3. Insert your disc into the new drive. 

Try using your recorder as both the source and destination drive  

When you use your recorder to both read and write to your disc, the contents of your disc is copied to 
your hard drive and that temporary file is copied back to your blank media. This can be helpful if the drive 
you're using to read your source disc is slow or unreliable.  
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Buffer underrun error  

Recording to a disc is a resource-sensitive process. If anything interrupts the flow of data during the 
recording process, the recording may fail. To avoid this type of error, close other applications running on 
your computer while recording.  

If you still experience recording errors after closing other applications, refer to your recorder's User Guide 
for more information.  
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Error while copying a disc  

Not all discs can be copied. For example, some DVDs and music CDs are created with a copy-protection 
feature. CDs and DVDs created with packet-writing software such as DLA (Drive Letter Access) also 
cannot be copied.  

Be sure the disc you are trying to copy is not copy-protected and is not a CD created with packet-writing 
software.  

DLA and similar products allow you to copy files to a recordable CD or DVD disc by dragging the files to 
the disc window or icon. The software is provided with many new computers and disc recorders.  
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Optical recorder drives in use by other applications  

When a disc is being recorded, the source and target drives are constantly being monitored by the 
recording software. If any of the disc drives are being used by applications other than the recording 
application, the recording will fail.  

  To avoid this error:  

� Close other applications while recording a disc. 

� Turn off the AutoPlay feature for your drive (see your Windows manual or Windows Help for full 
instructions). 

If DLA (Drive Letter Access) is installed on your computer, you may occasionally see a message stating 
that DLA is using the drive you intend to use to burn a disc. This most frequently occurs if you attempt to 
use this application immediately after inserting a disc in your drive. If this message appears, wait 15 
seconds for DLA to relinquish control of the drive then continue with your project.  
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Missing or wrong type of files  

The specified file cannot be recorded for one of the following reasons:  

� The application could not open the file. 

� The file is in use by another application. 

� The file has been deleted or the name or path have changed. 

� The file name is too long (110 characters maximum). 

� There is a problem with the video files you are trying to burn. Please consult your video creation 
software to confirm that you are creating a properly formatted video project. 

� The WMA file is copy protected, and the license required to copy it cannot be found on your 
system. 
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Scanning for music files  

Media Studio can scan your hard drive for valid audio files. A valid audio file must be in WAV, MP3, M4A, 
or WMA format for an audio CD. Once Media Studio has scanned your hard drive for valid files, you can 
build your music playlist from those files.  
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Note: QuickTime 6.4 or greater is required to support M4A files.  
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Recording error  

Recording errors often occur when the media contains dirt, fingerprints, or scratches.  

If you are getting recording errors:  

� Try using a new disc.  

� Try using a different manufacturer's disc.  

� Ensure the disc is clean before recording:  

� Remove all fingerprints, dirt, and dust from the shiny side of your disc using a 
nonabrasive cloth with a mild, nonabrasive soap solution. 

� Wipe the disc from the center to the edge.  

Dry the disc completely.  
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Not enough space on the disc  

The target disc does not have enough space to store all the information being written to it.  

To avoid this error, try one of the following suggestions:  

Check disc capacity  

Since disc media come in different information capacities, ensure that your target media is larger than the 
source media (e.g., your target media is an 80-minute capacity disc and your source media is a 74-
minute capacity disc).  

Note: If your recorder allows overburning (recording more information than the target disc is 
capable of holding) you run the risk of a failed recording. See your recorder's User Guide for details.  

Delete audio tracks or data files from the recording project  

� An audio CD can contain up to 74 or 80 minutes of music or a total of 99 tracks. 

� A compact disc can contain up to 650, 700, or 800 MB of data. 

� Single-layer DVDs can contain up to 4.7 GB of information. Double-layer DVDs can contain up 
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to 8.5 GB of information. 

Remove some audio tracks or data files from your project, then try recording again.  
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Not enough space on the hard drive  

During certain types of recordings, a copy of the source disc will be temporarily stored as an image file on 
an available hard drive. To avoid recording errors, make sure you have enough space on your hard drive 
to store the image.  

  To determine how much space you have available on your hard drive:  

1. Double-click My Computer.  

2. Right-click the hard drive icon, then select Properties. 

3. Note the amount of free space Windows reports.  

4. Repeat steps 2 and 3 for any additional hard drives on your computer.  

Depending on the type of recording and the size of the source disc, your hard drive should have between 
100 MB and 5 GB of free space.  

If your hard drive does not have enough free space, follow these suggestions:  

Empty the Recycle Bin  

1. Double-click the Recycle Bin icon on your Windows desktop.  

2. Select the files you want to delete, then choose File > Delete. 

Run Disk Cleanup  

Disk Cleanup is a Windows utility that helps you remove unneeded files from your hard drive. To start 
Disk Cleanup, follow these steps:  

1. Click on the Windows Start button, choose All Programs > Accessories > System Tools, then 
click on Disk Cleanup.  

2. Follow the instructions to clean up your hard disk. 

Uninstall one or more unneeded programs  

If your hard drive is still too full, try un-installing one or more unneeded programs.  

Refer to your Windows user guide or Windows Help for complete instructions on uninstalling programs.  
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Testing issues with the disc  

During the testing phase, (before the actual recording) an error occurred with the recordable disc.  

  To resolve this issue:  

� Clean the disc 

� Remove all fingerprints, dirt, and dust from the shiny side of your disc using a 
nonabrasive cloth with a mild, nonabrasive soap solution. 

� Wipe the disc from the center to the edge.  

� Dry the disc completely.  

Try a different blank, recordable disc.  
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Unknown error  

An error of unknown type has occurred.  
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An error occurred while verifying files  

After recording a data disc, one or more files did not verify correctly with the original source file.  

  To resolve this error:  

� Try again with a different disc. 

Refer to your recorder's User Guide for more information.  
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Displaying audio information  

Windows Media Player is used throughout the project launcher to display information about audio files 
and discs. This information is only displayed if Windows Media Player is installed on your computer and 
configured correctly. Windows Media Player is available as a free download from Microsoft.  

Follow the steps below to correctly configure your version of Windows Media Player.  
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  Windows Media Player version 7.1:  

1. Open Windows Media Player. From the Windows Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click on the Media Library tab. 

4. Choose Read-only access or Full access from the Internet site rights section. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

  Windows Media Player version 8:  

1. Open Windows Media Player. From the Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click on the Media Library tab. 

4. Choose Read-only access or Full access from the Access rights of Internet sites section. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

  Windows Media Player version 9:  

1. Open Windows Media Player. From the Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click the Privacy tab. 

4. Click on the box next to the Retrieve media information for CDs and DVDs from the Internet 
option if it is not already selected. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

  Windows Media Player version 10:  

1. Open Windows Media Player. From the Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click the Privacy tab. 

4. Click on the box next to the Display media information from the Internet option if it is not 
already selected. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

Note: If Windows Media Player is not present on your computer or is configured incorrectly, song 
titles will appear as "Track 1", "Track 2", etc. This will not affect your ability to record these songs to 
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a disc.  
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Audio projects  

All audio projects are grouped under the Audio tab.  

  To open a new Audio project:  

1. Click on the Audio tab in the project list. 

A list of projects is displayed.  

 

  

Audio tab project list  

2. Click on a project title to start a new project in the Project Window. 

or  

3. Click on Audio Guide to learn more about each available project. 

Other topics:  

� Audio system requirements 

� Making an audio CD 

� Using the mini-UI to make an audio CD 

� Using Quick Find 

� Audio options 
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Audio system requirements  

The Audio plug-in has the following system requirements:  

� Operating system support: 

� Windows 2000 with Service Pack 4 

� Windows XP Home Edition 

� Windows XP Professional Edition 

��������	�
���
�������
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� Windows XP Media Center Edition 2005 

� Windows XP 64-Bit Edition 

� Windows Media Player 7.1 or greater to: 

� obtain basic WMA support 

� Windows Media Player 9 or greater to: 

� obtain audio CD titles from the Internet 

� burn playlists 

� burn protected WMA files 

� QuickTime 6.4 or greater to: 

� obtain M4A support 

� A CD or DVD recorder for burning discs 

Tip: Windows Media Player is available free from the Microsoft Web site. The QuickTime player is 
available free from the Apple Computer Web site.  

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Making an audio CD  

Use the Audio CD project to record songs from CDs and from files stored on your computer. The Audio 
CD project creates a standard audio CD that can be played in almost any car or home CD player, in most 
computers, and in compatible set-top DVD players.  

Click on the link below to begin:  

� Starting an Audio CD project 
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Starting an Audio CD project  

  To open a new Audio CD project:  

1. Click on the Audio tab in the project list. 

A list of projects is displayed.  
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Audio tab project list  

2. Click on the Audio CD project. 

An Audio CD project opens in the project window.  

 

  

The Audio CD project window  

  To open a saved Audio CD project:  

� Choose File > Open and navigate to the project file you wish to open. By default, saved project 
files have a .sonic file name extension and are stored in your My Documents folder. Recent 
Projects are also listed under the File menu. 

or  

� Double-click on an Audio CD project file. The project is displayed in the project window. 

Click on one of the links below to continue:  

� Adding songs already stored on your computer 

� Adding songs from CDs 

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Adding songs already stored on your computer  

Songs stored on your computer can be added to an Audio CD project in the following ways:  

� By clicking on the Add Music button and navigating to the files on your computer. 
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Add Music button  

� By dragging music files from a directory window to the Audio CD project window. 

� By using the Quick Find panel to scan your hard drive, sort your music, and add your files. 

  The following steps describe how to add songs using the Quick Find panel:  

1. Click on the Quick Find button if the Quick Find panel is not already open. 

 

  

Quick Find button  

2. Click on the Scan button to search your hard drive for music files. The results of the scan will be 
displayed in the Quick Find panel. (M4A files will only be listed if QuickTime 6.4 or greater is 
installed on your computer.) 

 

  

A scan can take several minutes, depending on the size of your hard drive.  
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Tip: You have the option to skip short music files when scanning your hard drive for music. 
See Audio options — Quick Find panel for more information.  

3. Once all the valid music files on your system are displayed, you can sort them by selecting a 
category from the View drop-down menu. 

 

  

Click on the View menu to sort files by artist, album, genre, or by one of the other available 
categories.  

4. Select the files, folders, or playlists you wish to add from the Quick Find panel and click on the 
Add button at the bottom of the panel. 

The selected files move to the project window.  

The media information display on the left side of the control panel is updated to show the 
available time remaining on your disc. If the songs you have added won't fit on a CD, the 
indicator will alert you.  

Note: The media information display for an Audio CD project assumes you will be using a 
CD with a capacity of 700 MB unless you insert a disc with a different capacity into your 
recorder drive.  

Click on one of the links below to continue:  

� Adding songs from CDs 

� Completing the project 
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Adding songs from CDs  

1. After opening an Audio CD project, insert a music CD into your recorder drive. 

2. Click on the Quick Find button if the Quick Find panel is not already open. 
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Quick Find button  

3. If the songs on your CD do not automatically appear in the Quick Find panel, click on the View 
drop-down menu and choose the On Drive option for the drive containing the disc you wish to 
display. 

4. In the Quick Find panel, select the songs you wish to add and click on the Add button. 

The selected files move to the project window.  

5. To add songs from another CD, eject the first CD and insert the next CD. Repeat the steps 
above to add songs from this next disc. 

Note: As you select songs from an audio CD, they are temporarily stored on your computer's hard 
drive. You will need up to 700 MB of free space on your hard drive to successfully select all the 
songs on an audio CD.  

Click on one of the links below to continue:  

� Adding songs already stored on your computer 

� Completing the project 
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Completing the project  

Once all the songs for your project have been moved to the project window, you are ready to put them in 
order and record them onto a disc. Complete the project by following these steps:  

1. Arrange the song order in the project window by selecting a song and clicking on the Up or 

Down arrows  . 

2. Insert a blank or rewritable CD in your recorder drive. 

3. Select the recorder drive from the destination drop-down menu in the control panel. 

4. Check the media information display to confirm that the songs in your project will fit on your disc. 
If the songs will not fit, click on one or more song titles to select them, then click on the Remove 

button  . 

Note: Clicking on the Remove button  deletes the highlighted song from your list but 
does not affect any files on your hard drive.  

5. Click on the action button  . 
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A progress bar appears, and your disc is recorded.  

6. A completion screen appears. Click on the Label Disc button to make a label. Click on the 
Make Another button to make another copy of the disc. Click on the Done button to return to 
the project window. 

Note: The Label Disc button will not appear if Sonic's disc labeling software is not 
detected on your computer.  

7. To save this project so the same file set can be easily selected in the future, click on the Save 
button.  

8. To save this project as a playlist, click on the Save As Playlist button. Select a name and 
destination for the file, and click on the OK button. This saves the file set as an .m3u playlist file. 

Note: If your project contains songs that were copied directly from other CDs, you will not 
be able to save the project or save the file set as a playlist.  

9. Remove the discs from your drives and store them in a safe place. 

Other topics:  

� Using the mini-UI to make an audio CD 

� Starting an Audio CD project 

� Adding songs already stored on your computer 

� Adding songs from CDs 
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Using the mini-UI to make an audio CD  

Audio CDs can also be created using the mini-UI.  

  

The mini-UI with the Audio CD project selected  

  To make an audio CD using the mini-UI:  

1. If necessary, switch to the miniature user-interface by clicking on the Switch button located in 
the upper right-hand corner of the full-size application window. 
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The Switch button  

The mini-UI is displayed. If the Audio CD project window is already displayed, you can skip 
steps 2 and 3.  

2. Click on the project icon on the upper left-hand side of the mini-UI to access the project menu. 

3. Click on the Audio CD project icon  . 

4. Add audio files to your project by clicking on the Find Music button  or by dragging files to 
the project display area. 

The project display area initially displays the message Drag and Drop Music Here. As songs 
are added, the message changes to tell you of the number of songs in your project and the time 
remaining on your disc.  

5. Select the drive you would like to use to burn your disc from the Destination Selection menu. 

6. Click on the action button  to begin burning your disc. 

Note: You must switch to the full-size user application window by clicking on the Resize button  to 
review song titles, remove songs, or change the song order.  
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Making a Jukebox CD or DVD  

A typical audio CD only contains 10 to 20 songs. This is because the format used to create audio CDs 
produces large, uncompressed files.  

A Jukebox CD or DVD, on the other hand, can hold hundreds of songs because compressed audio files 
copied to a Jukebox disc stay compressed. Jukebox discs can be played on computers, music players, 
and set-top DVD players that are capable of playing MP3, WMA, WAV, or M4A files. Consult the user 
guide for your device to learn more about the disc and file formats it supports.  

When you insert a Jukebox disc into your computer, the disc begins playing automatically. The songs 
play in the order you set using the Jukebox CD/DVD project.  

Note: Many music players can play MP3 and WMA files, but few can play M4A files. If your music 
player does not recognize the format of a song on your disc, the song will be skipped. (QuickTime 
6.4 or greater is required to record M4A files.)  

  To make a Jukebox CD or DVD:  

1. Click on the Audio tab in the project list. 
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A list of projects is displayed.  

 

  

Audio tab project list  

2. Click on the Jukebox CD/DVD project. 

A Jukebox CD/DVD project opens in the project window.  

 

  

The Jukebox CD/DVD project window  

3. Click on the Quick Find button if the Quick Find panel is not already open. 

 

  

Quick Find button  

4. Click on the Scan button to search your hard drive for music files. 
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A scan can take several minutes depending on the size of your hard drive.  

Tip: You have the option to skip short music files when scanning your hard drive for music. 

Click on the Options button  and select the Audio options panel to change your 
settings.  

5. Once all the valid music files on your system are displayed, you can sort them by selecting a 
category from the View drop-down menu. 

 

  

Click on the View menu to sort files by artist, album, genre, or by one of the other available 
categories.  

6. Select the files, folders, or playlists you wish to add from the Quick Find panel, and click on the 
Add button. 

The selected files move to the project window.  

7. Arrange the song order in the project window by selecting a song and clicking on the Up or 

Down arrows  . 

8. Make sure a blank or rewritable CD or DVD is in your recorder drive. 
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9. Check the media information display to confirm that the songs in your project will fit on your disc. 

If the songs will not fit, click on one or more song titles then click on the Remove button  . 

Note: Clicking on the Remove button  deletes the highlighted song from your list but 
does not affect any files on your hard drive.  

10. To begin recording your disc, click on the action button  . 

A progress bar appears, and your disc is recorded.  

11. A completion screen appears. Click on the Label Disc button to make a label. Click on the 
Done button to return to the project window. 

Note: The Label Disc button will not appear if Sonic's disc labeling software is not 
detected on your computer.  

12. To save this project so the same file set can be easily selected in the future, click on the Save 
button. 

13. To save this project as a playlist, click on the Save As Playlist button. Select a name and 
destination for the file, and click on the OK button. This saves the file set as an .m3u playlist file. 

14. Remove the discs from your drives and store them in a safe place. 

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Jukebox disc tips and tricks  

� If some of the songs are skipped when you play a Jukebox CD or DVD, your music player may 
not be compatible with all of the music formats on your disc. For instance, some systems can 
read MP3 files, but not WAV files. For more information, consult the documentation that came 
with your device. 

� You can create a Jukebox disc containing copy protected WMA files, but those files will only 
play on the computer used to create them. 

� Before a song from a commercial music CD can be copied to a Jukebox disc project, the song 
must be converted to MP3, WMA, M4A, or WAV format. 

� Once a Jukebox disc is recorded on a write-once disc, no additional data can be added. A 
Jukebox disc recorded on a rewritable disc must be erased before data can be added. 

� Jukebox discs cannot be created using the mini-UI. 
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Using Quick Find  

The Quick Find panel offers the easiest way to scan your hard drive for music files, sort them into 

Page 36 of 95Getting Started

6/29/2006file://C:\Documents and Settings\dpsuser\Local Settings\Temp\~hh412D.htm



categories, and add them to your projects.  

  To open the Quick Find panel:  

� Click on the Quick Find button. 

 

  

Quick Find button  

  To close the Quick Find panel:  

� Click on the Quick Find button when the panel is open. 

  To scan your hard drive for music files:  

� Click on the Scan button. When the scan is complete, your music files will be listed in the panel 
window. 

 

  

A scan can take several minutes, depending on the size of your hard drive.  

  To sort your music files:  

� Click on the View menu to open it, then select one of the available categories. The results will be 
displayed in the panel window. You can also use the View menu to display playlists or the 
contents of a music CD inserted in one of your disc drives. See Using playlists for more 
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information. 

 

  

Click on the View menu to sort files by artist, album, genre, or by one of the other available 
categories.  

  To add files, folders, or playlists to a project:  

� Select the items you wish to add, then click on the Add button at the bottom of the Quick Find 
panel. You can also drag files directly from the Quick Find panel to the project window. (Adding 
a playlist to a project adds all of the songs included in the playlist as long as the songs can be 
found on your system.) 

  To listen to a song:  

� Click on a song title in the Quick Find panel, then click on the Preview button. 

 

  

The Preview button  

Notes about using Quick Find:  

� Windows Media Player 9.0 or greater is required to enable playlist support. If you have an earlier 
version of Windows Media Player on your system, By Playlist will not appear as an option on 
the View menu. 

� When you scan your system for audio files, a list of your files is created and stored on your 
computer. The next time you open Quick Find, the results of your most recent scan are 
automatically loaded. Loading this file can take a minute or two if you have a large collection of 
music. 

� To listen to M4A files with the Preview button, you must first install a M4A decoder for your 
version of Windows Media Player. (The decoder is not needed to burn M4A files.) 
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Using playlists  
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Note: Windows Media Player 9.0 or greater is required to enable playlist support. If you have an 
earlier version of Windows Media Player on your system, By Playlist will not appear as an option 
on the View drop-down list. Free upgrades of Windows Media Player are available on Microsoft's 
Web site.  

Most music players allow you to create playlists — files containing the titles and locations of the digital 
music you enjoy. When you select a playlist, the music player finds the songs and plays them in order.  

Use playlists to make quick work of your audio recording projects. You can:  

� Save the list of files in an audio project as a playlist using the Save As Playlist button.  

� Scan for playlists on your system and view the song titles they contain. See Using Quick Find for 
more information. 

� Drag playlists directly from the Quick Find window to the project window. 

� Use the Up and Down arrow buttons  found in the audio project window to rearrange 
songs within a playlist and burn them to a disc. 

Note: Playlists with the following file name extensions are supported: .m3u, .asx, and .wpl. Playlists 
created using the Save As Playlist button are saved as .m3u files.  
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Playing music  

The project launcher includes a built-in music player you can use to preview the songs in your projects. 
Listen to a single song or the full list of songs displayed in the project window.  

Once a song begins to play, a set of audio playback controls appear in the control panel at the bottom of 
the project window. The controls can be used to jump to the next or previous song, pause a song, adjust 
the volume, or mute the sound.  

Songs can be played using either the full-size application window or the mini-UI.  

  To play music using the full-size application window:  

� Select Playback Controls from the Destination Selection menu to display the audio playback 
controls. Select a song in either the project window or the Quick Find panel, and click on the 
Play button. 

or  

Right-click on a song and select Preview Song from the shortcut menu.  

or  

Select a song in the Quick Find panel, and click on the Preview button .  
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The Preview button  

  To play music using the mini-UI:  

� Click on the Open File button. A file selection window appears. Select one or more songs, and 
click on the Open button. 

or  

Drag songs from a directory window to the project display area of the mini-UI.  

In both cases described above, the songs begins playing and a set of playback controls appears on the 
mini-UI.  

Note: To listen to M4A files using the project launcher, you must first install a M4A decoder for your 
version of Windows Media Player. (The decoder is not needed to burn M4A files.)  

Other topics:  

� Using the audio playback controls 
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Using the audio playback controls  

Songs can be played using either the full-size application window or the mini-UI. The tables below 
describe many useful features.  

Audio playback: Control panel 

  

   Feature  Function  

Destination Selection/Playback Click on Destination Selection and choose Playback 
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Audio playback: Mini-UI 

Note: To listen to M4A files using the project launcher, you must first install a M4A decoder for your 

  
Controls drop-down menu  Controls from the menu to display the audio playback 

controls.  

  
Progress slider  Drag this slider right to advance a song.  

  
Mute button  Click here to mute the audio playback.  

  
Volume control  Click on the + or — controls to change the volume.  

  
Previous button  Click here to play the previous song.  

  
Next button  Click here to play the next song.  

  
Stop button  Click here to stop audio playback.  

  
Play/Pause button  Click here to play or pause the current song.  

  

   Feature  Function  

  
Current project icon  Click here to change projects.  

  
Add files button  Click here to add files.  

  
Switch button  Click here to open the full-size version of the application window.  

  
Close button  Click here to close the application.  

  
Minimize button  Click here to minimize the application to the Windows taskbar.  

  
Help button  Click here to open the Help file.  
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version of Windows Media Player. (The decoder is not needed to burn M4A files.)  

Other topics:  

� Playing music 
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Audio options  

Click on the Options button  on the control panel to open the Options window. Here you will find 
settings that can be used to customize your projects.  

Each available group of options is displayed in the left-hand pane. Click on the name of an options group, 
and those option settings appear on the right.  

Audio options — Audio panel  

Use the Audio panel to customize the following settings:  

General music options  

� Warn that audio discs are not appendable: Once an audio disc is burned, you can no longer 
add files to it. You will be reminded of this if a check mark appears in this box. 

� Enable CD information lookup: Select this option to gather song information over the Internet. 
This information includes song titles, artist name, album name, genre, and other information. 

Audio options — Audio CD panel  

Use the Audio CD panel to customize the following settings:  

� Normalize tracks to a consistent level: This option sets the volume of songs in an audio 
project to a consistent level. The level is set by selecting the checkbox and moving the slider left 
or right. A setting of 90 percent, for example, sets the volume of all tracks in the current project 
to 90 percent of the loudest song. Normalization is turned off by default. 

� Reduce background noise using pre-emphasis: Selecting this checkbox raises the recording 
level of higher audio frequencies as part of a noise reduction technique. 

Audio options — Quick Find panel  

Use the Quick Find options panel to customize the following settings:  

� Hide audio files shorter than (in seconds): Select this checkbox to limit your scans to audio 
files longer than the number of seconds you specify. This number can be from 1 to 180 seconds. 

This option will speed up your next scan by eliminating short audio files, such as the one you 
hear when Windows starts up. It does not affect playlists.  

� Scan for Music location options: These controls determine the extent of the search that occurs 
when you click on the Scan button on the audio Quick Find panel. 

� Select Local Hard Drives to scan the hard drives on your computer for music files. 
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� Select the custom path option (the option directly below Local Hard Drives) to limit 
audio scans to a single directory. By default this limits scans to your My Documents 
directory. Change the directory by clicking the custom path option, then clicking on the 
Browse button. Navigate to a location of your choice. 

Note: For information about audio options not described here, consult this Help file's index under 
the heading "Options."  

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Audio tips and tricks  

The following topics offer advice that will help you get the most from your recording projects:  

� General audio tips 

� Displaying song information 

� Renaming music files 

� Recording songs purchased from on-line music stores 

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

General audio tips  

� Windows Media Player 9 or greater is required to create audio CDs using copy protected WMA 
files. Refer to the application that created the WMA files for more information on copy protection. 

� You have the option to skip short music files when scanning your hard drive for music. See 
Audio options for more information. 

Other topics:  

� Displaying song information 

� Renaming music files 

� Recording songs purchased from on-line music stores 
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Displaying song information  

Windows Media Player is used throughout the project launcher to display information about audio files 
and discs. This information is only displayed if Windows Media Player is installed on your computer and 
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configured correctly. Windows Media Player is available as a free download from Microsoft.  

Follow the steps below to correctly configure your version of Windows Media Player.  

  Windows Media Player version 7.1:  

1. Open Windows Media Player. From the Windows Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click on the Media Library tab. 

4. Choose Read-only access or Full access from the Internet site rights section. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

  Windows Media Player version 8:  

1. Open Windows Media Player. From the Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click on the Media Library tab. 

4. Choose Read-only access or Full access from the Access rights of Internet sites section. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

  Windows Media Player version 9:  

1. Open Windows Media Player. From the Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click the Privacy tab. 

4. Click on the box next to the Retrieve media information for CDs and DVDs from the Internet 
option if it is not already selected. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  

  Windows Media Player version 10:  

1. Open Windows Media Player. From the Start menu, choose:  

All Programs > Accessories > Entertainment > Windows Media Player.  

2. Choose Tools > Options. 

3. Click the Privacy tab. 

4. Click on the box next to the Display media information from the Internet option if it is not 
already selected. 

5. Click on the OK button. 

Song information will be displayed the next time you start the application.  
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Note: If Windows Media Player is not present on your computer or is configured incorrectly, song 
titles will appear as "Track 1", "Track 2", etc. This will not affect your ability to record these songs to 
a disc. For information on adding song titles individually, see Renaming music files.  

Other topics:  

� General audio tips 

� Recording songs purchased from on-line music stores 
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Renaming music files  

  To rename a music file in an Audio CD project:  

1. Click once on the song name in the project window. 

2. Press the F2 key on your keyboard. 

3. Type the new name for the song. 

4. Press the Ent er  key on your keyboard. 

Other topics:  

� General audio tips 

� Displaying song information 

� Recording songs purchased from on-line music stores 
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Recording songs purchased from on-line music stores  

Songs purchased from on-line music stores that use the protected WMA audio format can be burned as 
long as Windows Media Player 9 or greater is installed on your computer. If your project includes files that 
cannot be copied, you will be notified.  

Keep the following guidelines in mind when creating audio projects with files purchased on-line:  

� A protected WMA file can be recorded if the license to copy the file resides on your computer. 
The license is normally downloaded at the same time you download the audio file. 

� The copy restrictions imposed by each music service extend to the project launcher. For 
instance, if the music service allows you to burn a playlist up to five times, burning the playlist 
with the Audio CD project will count toward that limit. Consult your music service's Web site for 
information about use restrictions. 

� Protected WMA files are displayed after an audio scan, even if their burn count has reached 
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zero. 

� Audio files in the M4P format sold by Apple's iTunes music store cannot be burned. 

Other topics:  

� General audio tips 

� Displaying song information 

� Renaming music files 
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Copy projects  

All copy projects are grouped under the Copy tab.  

  To open a new Copy project:  

1. Click on the Copy tab in the project list. 

A list of projects is displayed.  

 

  

Copy tab project list  

2. Click on a project title to start a new project in the project window. 

or  

3. Click on Copy Guide to learn more about each available project. 

Other topics:  

� Copy system requirements 

� Copying a disc 

� Copy options 
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Copy system requirements  

The Copy plug-in has the following system requirements:  

� Operating system support: 

��
����	�
���
�������
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� Windows 2000 with Service Pack 4 

� Windows XP Home Edition 

� Windows XP Professional Edition 

� Windows XP Media Center Edition 2005 

� Windows XP 64-Bit Edition 

� A CD or DVD recorder for copying discs 
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Copying a disc  

Use the Disc Copy project to perform the following tasks:  

� Copy audio CDs that are not copy protected 

� Copy CD and DVD discs containing data and application files 

If you have one CD or DVD recorder, Disc Copy will copy your master disc and store the data to a 
temporary location on your hard drive. You will then be asked to insert a blank or rewritable disc, and the 
data will be copied from your hard drive to the disc. To successfully copy a disc, your hard drive must 
have enough space available to store this temporary file.  

If you have more than one CD or DVD recorder, you can choose to copy your master disc directly to a 
blank or rewritable disc in your second drive.  

Other topics:  

� Disc Copy instructions (using one drive) 

� Disc Copy instructions (using two drives) 

� Using the mini-UI to copy a disc 

� What CDs can be copied? 

� What DVDs can be copied? 

� Copying from one CD format to another 

� Copying from one DVD format to another 
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Disc Copy instructions (using one drive)  

If you have one CD or DVD drive, Disc Copy will copy your master disc and store the data to a 
temporary location on your hard drive. You will then be asked to insert a blank or rewritable disc, and the 
data will be copied from your hard drive to the disc. To successfully copy a disc, your hard drive must 
have enough space available to store this temporary file.  

  To copy a disc using one drive:  
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1. Click on the Copy tab in the project list. 

A list of projects is displayed.  

2. Click on the Disc Copy project. 

 

  

Copy tab project list  

3. Insert the master disc into your recorder drive. If you have more than one recorder drive, choose 
a drive from the drop-down list in Step 2 of the on-screen instructions. 

4. Click on the action button  . 

An image file is created from your master disc and is stored temporarily on your hard drive.  

5. Once the temporary image file is created, remove the master disc from your recorder drive and 
insert a blank or rewritable disc. 

A copy of your master disc is created.  

6. A project completion screen appears. 

7. Click on the Label Disc button if you wish to make a label for your disc. Click on the Make 
Another button to make another copy of the disc. Click on the Done button to return to the 
project window. 

8. Remove the disc from your drive and store it in a safe place. The temporary image file used to 
create your copy will be automatically deleted. 

Other topics:  

� Disc Copy instructions (using two drives) 

� Using the mini-UI to copy a disc 

� What CDs can be copied? 

� What DVDs can be copied? 

� Copying from one CD format to another 

� Copying from one DVD format to another 
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Disc Copy instructions (using two drives)  

If you have more than one CD or DVD drive, you have a choice to make:  

� You can copy your master disc from one drive directly to a blank or rewritable disc in a second 
drive. 

or  
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� You can stage the project to a temporary location on your hard drive before burning it to a disc. 
Staging the project takes longer but can reduce the chance of a burn failure with some drives. 

Note: Direct disc-to-disc copies cannot be created if the Stage to hard drive for better 
quality option is selected on the Copy options panel. See Copy options for more 
information.  

  To copy a disc using two drives:  

1. Click on the Copy tab in the project list. 

A list of projects is displayed.  

2. Click on the Disc Copy project. 

 

  

Copy tab project list  

3. Insert the master disc into one of your drives and select that drive as the source drive in the first 
drive drop-down menu displayed in the project window. The source drive does not have to be 
capable of recording a disc. 

4. Select a destination drive from the second drive drop-down menu displayed in the project 
window. Only recorder drives are listed. 

For a direct disc-to-disc copy, the destination drive and source drive must be different, and the 
Stage to hard drive for better quality option must not be selected.  

5. Click on the action button  . 

Insert a blank or rewritable disc into your destination drive, if you are asked to do so. A copy of 
your master disc is created.  

6. A project completion screen appears. 

7. Click on the Label Disc button if you wish to make a label for your disc. Click on the Make 
Another button to make another copy of the disc. Click on the Done button to return to the 
project window. 

8. Remove the discs from your drives and store them in a safe place. If a temporary image file was 
used to create your copy, it will be automatically deleted. 

Other topics:  

� Disc Copy instructions (using one drive) 

� Using the mini-UI to copy a disc 

� What CDs can be copied? 

� What DVDs can be copied? 

� Copying from one CD format to another 

� Copying from one DVD format to another 
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Using the mini-UI to copy a disc  

The Disc Copy project is also available on the mini-UI.  

  

The mini-UI with the Disc Copy project selected  

  To make a Disc Copy using the mini-UI:  

1. If necessary, switch to the miniature user-interface by clicking on the Switch button located in 
the upper right-hand corner of the full-size application window. 

 

  

The Switch button  

The mini-UI is displayed. If the Disc Copy project window is already displayed, you can skip 
steps 2 and 3.  

2. Click on the project icon on the upper left-hand side of the mini-UI to access the project menu. 

3. Click on the Disc Copy project icon  . 

4. Select a source drive and a destination drive. If the same drive is selected as both the source 
and destination drives, an image file will be created from your master disc and stored 
temporarily on your hard drive. 

5. Click on the action button  to begin creating your disc. 

Other topics:  

� Disc Copy instructions (using one drive) 

� Disc Copy instructions (using two drives) 

� What CDs can be copied? 

� What DVDs can be copied? 

� Copying from one CD format to another 

� Copying from one DVD format to another 
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What CDs can be copied?  

The Disc Copy project can be used to copy almost any unencrypted CD. Follow these guidelines for best 
results:  

� Select a target disc that is the same size and format as the source disc. 

� Make sure the disc speed is compatible with your recorder drive. 

More technical details are available in the chart below:  

The following disc types can be copied  

Disc type  Description  

Data CD-ROM  Data Mode 1, Disc-at-Once. (The format of most commercial CD-ROMs for data 
or software distribution.)  

Kodak Photo CD  

   

Data Multisession. Mode 2 XA, mixed form. Track-at-Once. (The format used by 
Kodak photo finishers.)  

Data Mode 1 
Multisession, 
closed  

Data Multisession. Mode 1, with last last session not appendable. Track-at-Once. 
It can contain one or more sessions, each containing Mode 1 data tracks.  

Data Mode 1 
Multisession, 
open  

Same as above, but the last session is appendable.  

Data Mode 2 
Multisession, 
closed  

Data Multisession. Mode 2, with last last session not appendable. Track-at-Once. 
It can contain one or more sessions, each containing Mode 2 data tracks.  

Data Mode 2 
Multisession, 
Open  

Same as above, but the last session is appendable.  

Data Mode 2 
Disc-at-Once  

Like a standard stamped CD-ROM, but mastered as Mode 2. It is not very 
common.  

Classic audio disc  Audio Disc-at-Once Silver, like almost any commercial music disc, or Closed 
Gold.  

Audio disc, not 
closed  

Audio Gold disc not closed (track-at-once or session-at-once).  

CD Extra or 
Enhanced CD  

A disc with a first audio session with the music tracks and then a second session 
with a Data Mode 2 XA track.  

Audio Track-at-
Once, not closed  

Audio Track-at-Once tracks in a not yet closed session. This is an in-progress 
audio disc, that can be played in a CD recorder but not in a consumer CD player.  

Classic Mixed-
mode  

A data session containing a data track followed by one or more audio tracks. This 
is the most common type of Mixed-mode. An audio player will not play the data 
track or, occasionally, will make a loud noise. A computer's CD-ROM drive will 
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Other topics:  

� Disc Copy instructions (using one drive) 

� Disc Copy instructions (using two drives) 

� Using the mini-UI to copy a disc 

� What DVDs can be copied? 

� Copying from one CD format to another 

� Copying from one DVD format to another 
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What DVDs can be copied?  

The Disc Copy project can be used to copy almost any unencrypted DVD. Follow these guidelines for 
best results:  

� Make sure the disc speed and disc format is compatible with your recorder drive. 

� If you plan to play your DVD in a set-top DVD player, make sure the disc format and speed are 
compatible with the player. You may wish to experiment with discs made by different 
manufacturers to determine which work best with your player. 

More technical details are available in the chart below. 

Other topics:  

� Disc Copy instructions (using one drive) 

� Disc Copy instructions (using two drives) 

� Using the mini-UI to copy a disc 

� What CDs can be copied? 

see the disk as a CD-ROM disc.  

Mixed-mode 
Track-at-Once  

As above, but Track-at-Once.  

Video CD  A standard XA disc with one or more Mode 2 data tracks in a XA session, but 
with additional logical information. Discs created in Super Video CD format 
(SVCD) cannot be copied.  

The following disc types can be copied  

Disc type  Description  

Data DVD  Any mastered data DVD containing UDF, ISO, or Joliet file systems.  

DLA DVD  Any DVD created by Drive Letter Access (DLA) 3.5 or later.  

DVD-Video  Any unprotected DVD-Video disc 4.3 GB or less.  
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� Copying from one CD format to another 

� Copying from one DVD format to another 
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Copying from one CD format to another  

CD discs are available in two formats: write-once CD-R discs and rewritable CD-RW discs. We 
recommend that you always use discs that have the same format when making copies. However, you can 
copy the contents of a CD-R to a CD-RW disc and vice versa.  

Note: It is not possible to use the Disc Copy project to copy a CD disc onto a DVD disc or to copy a 
DVD disc onto a CD disc.  

Other topics:  

� Disc Copy instructions (using one drive) 

� Disc Copy instructions (using two drives) 

� Using the mini-UI to copy a disc 

� What CDs can be copied? 

� What DVDs can be copied? 

� Copying from one DVD format to another 
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Copying from one DVD format to another  

DVD discs come in many formats. We recommend that you always use discs that have the same format 
when making copies. However, it is sometimes possible to copy the contents of a DVD to a disc with a 
different format. The chart below provides guidelines for advanced users. Note that compatibility often 
depends on the limitations of your drive, whether the source disc has multiple borders, and whether the 
disc is open or closed. Use the Disc Information project on the Tools tab to learn more about the 
properties of any disc you would like to copy. 

DVD compatibility when making copies  

Source disc format  Compatible target discs  

DVD-R (single-
border/closed)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD-R (single-
border/open)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD-R (multi- DVD-R, DVD-RW (quick-erased)**, DVD-RW (full-erased)  
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* The copy will be successful if the data from the source disc fits into the first layer of the target disc.  

** A full erase of the target disc is required.  

*** The target disc will not be an exact copy. Border information will be lost.  

Note: It is not possible to use the Disc Copy project to copy a CD disc onto a DVD disc or to copy a 
DVD disc onto a CD disc.  

Other topics:  

� Disc Copy instructions (using one drive) 

� Disc Copy instructions (using two drives) 

� Using the mini-UI to copy a disc 

� What CDs can be copied? 

� What DVDs can be copied? 

� Copying from one CD format to another 

border/closed)  

DVD-R (multi-
border/open)  

DVD-R, DVD-RW (quick-erased)**, DVD-RW (full-erased)  

DVD+R (single-
border/closed)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD+R (single-
border/open)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD+R (multi-
border/closed)  

DVD+R, DVD+RW***  

DVD+R (multi-
border/open)  

DVD+R, DVD+RW***  

DVD-RW  
(Restricted Overwrite)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD-RW  
(single border)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD-RW  
(multi-border)  

DVD-R, DVD-RW (full-erased)  

DVD+RW  
(single-border)  

DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD-RAM  DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM, DVD+R9*  

DVD+R9 (single border)  DVD-R, DVD+R, DVD-RW (quick erased), DVD-RW (full-erased), 
DVD+RW, DVD-RAM  

DVD+R9 (multi-border)  DVD+R, DVD+R9  
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Burning an image  

The Burn Image project creates discs from image files saved on your hard drive. Your image files must 
have been saved in one of two file types: ISO or Global-Image.  

To learn how to create an image file from a disc, see Saving an image. For a more detailed discussion of 
image files and image file types, see Understanding image files.  

Other topics:  

� Burn Image instructions 

� Burn Image tips 
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Burn Image instructions  

  To record a disc from an image file:  

1. Click on the Copy tab in the project list. 

A list of projects is displayed.  

2. Click on the Burn Image project. 

 

  

Copy tab project list  

3. In the project window, select an image file to burn using one of the following methods: 

� Click on the Browse button and navigate to the image file on your hard drive. 

or  

� Click in the text box directly above the Browse button. A list of the last 10 image files 
you've created will appear. Choose an image file from the list. 

Note: By default, image files created with the Save Image project are stored in 
your My Documents folder.  

4. In the project window, choose a recorder drive from the drop-down list in Step 2. If your system 
has only one drive, its name will be automatically displayed. 
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5. Insert a blank or rewritable disc into your recorder. 

6. Click on the action button  . 

A copy of the original disc is created from the image file you selected.  

7. A project completion screen appears. 

8. Click on the Done button. Remove the disc from your drive and store it in a safe place.  

Other topics:  

� Burning an image 

� Burn Image tips 
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Burn Image tips  

� Discs used in a Burn Image project must be blank or rewritable. Any data contained on a 
rewritable disc will be erased before the image is burned. 

Other topics:  

� Burning an image 

� Burn Image instructions 
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Saving an image  

The Save Image project creates disc image files and saves them on your hard drive. These image files 
can be used to create new copies of your discs whenever you wish using the Burn Image project.  

To learn how to create a disc from an image file, see Burning an image. For a more detailed discussion of 
image files and image file types, see Understanding image files.  

Other topics:  

� Save Image instructions 

� Save Image tips 
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Save Image instructions  
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  To create a disc image:  

1. Click on the Copy tab in the project list. 

A list of projects is displayed.  

2. Click on the Save Image project. 

 

  

Copy tab project list  

3. In the project window, choose a drive from the drop-down list. If your system has only one drive, 
its name will be automatically displayed. 

4. Insert the disc you wish to make an image from into your disc drive. 

5. Click on the Browse button. 

The Save As window opens.  

6. Select a destination for the image file and give it a meaningful name. Select a file type from the 
Save as type drop-down list. (See Understanding image files for more information on image file 
types.) 

7. Click on the Save button on the Save As window to confirm your selections. 

8. Click on the action button  . 

A completion screen appears when the image file has been successfully created.  

9. Click on the Done button. 

Other topics:  

� Saving an image 

� Save Image tips 
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Save Image tips  

� By default, your image files will be saved in your My Documents folder. If you choose a 
different location, this new location will be remembered the next time you create an image file. 

� By default, your image files will be given the following name: Image_[date]_[time].gi. You are 
free to select a different name and different file type. 

Other topics:  
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� Saving an image 

� Save Image instructions 
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Understanding image files  

All the information stored on a CD or DVD can be converted into a single file called a disc image. That 
image file can then be used to reproduce the original disc. This is useful when you need to make several 
copies of the same disc but do not want to read from the source drive every time, or if you want to use 
your recorder to both read and write to your discs.  

By having the image file stored on your hard drive, you free up the source disc for other uses. You can 
also send the image file across a network so other people can record their own copies.  

Image file types  

There are several image file types or formats. Sonic has created a format known as Global-Image. 
Global-Image files contain not only the data files on a disc, but the exact placement of those files, their 
folder structure, read and write properties, and much more. Files in this format can be recognized by 
the .gi file name extension.  

Some mastering products cannot read Global-Image files, however. This could cause a problem if 
someone needed to create a disc from your image and they did not have the necessary Sonic software 
installed on their computer. For this reason, you also have the option to create images of data discs in a 
less complete, but more compatible, format known as ISO. Files in this format can be recognized by 
the .iso file name extension.  

The availability of the ISO image option depends on the type of disc (CD or DVD), the size of the file, and 
the number of tracks on the disc.  
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Copy options  

Click on the Options button  on the Control Panel to open the Options window. Here you will find 
settings that can be used to customize your application.  

Each available group of options is displayed in the left-hand pane. Click on the name of an options group, 
and those options settings will appear on the right.  

Each panel includes a Restore Defaults button that can be used to restore the default settings for the 
options on that panel only.  

Note: Not all options are available for all drives or operating systems. The Advanced options panels 
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are not available on all versions of this product.  

Copy options — Copy panel  

Use the Copy panel to customize the following settings:  

� Stage to hard drive for better quality (slower): When this option is selected, your Disc Copy 
projects will always be staged to your hard drive before burning them to a disc. Staging the 
project can reduce the chance of a burn failure with some drives. 

� Verify copied data discs (slower): A check mark in this box adds a verification step to ensure 
no errors occurred as your discs were copied. When copying Mixed Mode and CD Extra discs, 
the data portions of those discs are verified when this option is selected. 

What is a CD Extra disc? CD Extra is a format that contains both audio and data, with the audio 
stored in the first session. Computers read the data portion of the disc. Audio CD players play 
the audio tracks and ignore the data.  

What is a Mixed Mode disc? Mixed Mode is similar to CD Extra, but the data is stored on the 
first session. Older audio CD players will attempt to play this session, resulting in a loud noise 
that can damage your speakers.  

Other topics:  

Copying a disc  
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Data projects  

All data projects are grouped under the Data tab.  

  To open a new Data project:  

1. Click on the Data tab in the project list. 

A list of projects is displayed.  

 

  

Data tab project list  

2. Click on a project title to start a new project in the Project Window. 

or  

3. Click on Data Guide to learn more about each available project. 

Other topics:  

� Data system requirements 

� Copying files directly to a CD or DVD disc 
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� Data options 
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Data system requirements  

The Data plug-in has the following system requirements:  

� Operating system support: 

� Windows 2000 with Service Pack 4 

� Windows XP Home Edition 

� Windows XP Professional Edition 

� Windows XP Media Center Edition 2005 

� Windows XP 64-Bit Edition 

� Drive Letter Access (DLA) version 4.95 or greater to enable the Direct-to-Disc project 

� A CD or DVD recorder for burning discs 

Other topics:  

� Data options 
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Making a data disc  

A data disc is a CD or DVD used to store electronic data, such as the files and applications that reside on 
your computer's hard drive. Unlike audio CDs, data discs are primarily used to store files for use on a 
computer.  

You can add or append information to a data disc again and again until it is full. If you're using a 
rewritable disc, you have the choice of appending your new files or erasing the disc first and then adding 
new files.  

  To create a data disc:  

1. Click on the Data tab in the project list. 

A list of projects is displayed.  

 

  

Data tab project list  
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2. Click on the Data Disc project. 

A Data Disc project opens in the project window.  

 

  

The Data Disc project window  

Note: To open a saved Data Disc project, choose File > Open and navigate to the project 
file you would like to open. By default, saved projects are stored in your My Documents 
folder with a .sonic file name extension.  

3. Select a recorder drive using the drive drop-down menu on the control panel. 

4. Insert a blank disc into your selected recorder drive. 

5. If desired, type a name for your disc in the Volume Label text box at the top of the project 
window. 

 

  

Volume Label text box  

6. If your disc already contains files and they are not displayed in the project window, you can add 
them by clicking on the Load Disc button. 

7. Before adding new files in the project window, consider how you would like the files organized. 
New folders can be created directly on your disc. These folders can be named, and files can be 
moved directly into them. You will find it easier to organize your discs if you create these folders 
before you begin adding files. 

See Organizing files in a Data Disc project for more information.  

8. Add files using one or more of the following methods: 

� Click on the Add Data button and navigate to the files you wish to copy. Click on the 
files or folders to select them, then click on the Add button. 

� Drag files and folders directly from a directory window to the project window. 

� Open the Quick Scan panel. Select a source drive or folder and the file categories you 
would like to add. If desired, narrow your scan by using the Change Since calendar. 
Click on the Scan button. All files matching your scan criteria are added to the project. 

9. Check the media information display to confirm that the data in your project will fit on your disc. 
If the data will not fit, click on one or more files or folders and then click on the Remove button 

 . Removing files from a Data Disc project will not remove these files from 
your hard drive. 

10. To save this file list so the same list can be easily selected in the future, click on the Save 
button. 

11. Click the action button  to begin recording data to your disc. 

A progress screen will inform you when the project has been completed.  

12. Click on the Label Disc button if you wish to make a label for your disc.  
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Note: The Label Disc button will not appear if the disc labeling software is not detected on 
your computer.  

13. Click on the Done button to return to the project window. Remove the disc from your drive and 
store it in a safe place. 

When creating data discs, keep the following important issues in mind:  

� Write-once DVD media can only be appended if the correct compatibility setting was selected in 
the Data options panel.  

� The Data Disc project can be used to add data to an appendable disc that already contains 
data. See Using a disc that already contains data for more information. 

� The project launcher allows you to work on different types of Data projects at the same time. 
However, if you try to scan for files from two Data projects at once, the first scan will be put on 
hold until the second scan is finished. 

Note: Some versions of this product include an advanced option that allows Data Disc projects to 
span across more than one disc.  

Other topics:  

� Using a disc that already contains data 

� Organizing files in a Data Disc project 

� Adding and removing data from a Data Disc project 

� Making a data disc with the mini-UI 

� Using the Quick Scan panel 

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Using a disc that already contains data  

The Data Disc project can be used to add files to an appendable disc that already contains data. To do 
this you must load the existing files from your disc into your Data Disc project before you record any new 
files.  

If the files are not loaded first, you will not be able to complete your project unless you erase or replace 
your disc. Your choices will depend on the type of disc you are using. Messages explaining your options 
will appear on screen as you work.  

  To load files into a Data Disc project from an appendable disc:  

1. Insert an appendable disc into your recorder drive. 

2. Click on the Load Disc button. 

or  

Click on the Yes button when a message appears on your screen asking if you would like to 
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load the contents of your disc into the active project.  

Note: Some versions of this program include an option to always load appendable discs.  

Other topics:  

� Making a data disc 

� Organizing files in a Data Disc project 

� Adding and removing data from a Data Disc project 

� Making a data disc with the mini-UI 

� Using the Quick Scan panel 
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Organizing files in a Data Disc project  

Files and folders can be copied to a data disc with as much — or as little — organization as you desire. 
You can add individual files to a disc with no directory structure. You can add entire folders and maintain 
the directory structure within them. Or you can create an entirely new directory structure on your disc and 
then add files or folders to those new directories.  

The project toolbar includes several familiar buttons to help you organize your discs: 

In addition, the Data Disc project window displays the following information about each of the files 
included in your recording: Name, Size, Type, Path, and Modified. To view all of the file information, it 
may be necessary to enlarge the project window or adjust the width of each column of information.  

Other topics:  

� Making a data disc 

� Using a disc that already contains data 

� Adding and removing data from a Data Disc project 

� Making a data disc with the mini-UI 

� Using the Quick Scan panel 

Disc organization tools  

Button  Function  

  Displays the previous file directory  

  Moves up one file directory  

  Creates a new folder on your disc  

  Removes the selected file or folder  
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Adding and removing data from a Data Disc project  

Files can be added or "appended" to a disc as often as you like until the disc is full. You can also remove 
files, in a manner of speaking. The Remove button  completely removes file names that have been 
selected but not yet recorded. It can also be used to make already recorded files invisible to your 
computer. For more information, see Understanding the Remove button.  

  To add data to a Data Disc project:  

� Follow the same steps outlined in Making a data disc.  

  To remove data from a Data Disc project:  

1. Click on the name of the file in the project window to select it. 

2. Click the Remove button  . 

A dialog box will appear asking if you are sure you want to remove the selected item.  

3. Click Yes. 

4. Click the action button. 

Note: Clicking the Remove button does not affect any files on your hard drive.  

Understanding the Remove button  

As you begin to create a Data Disc project, the names of the files you add appear in the project window. 

The files are not actually copied until after the action button  is clicked.  

If you add a file and then wish to remove it before the recording process begins, use the Remove button 
 to delete the name of the file from the project window. The file will not be recorded and no disc space 

will be used by the deleted file.  

The Remove button can also be used to hide files that have already been recorded to a data disc. In this 
case, the files are not actually erased, but they can no longer be seen or read by your computer. The disc 
space occupied by these hidden files cannot be recovered for new recordings.  

A couple of other things worth noting:  

� As you add and remove files, the space used on your disc is displayed in the control 
panel at the bottom left corner of the application window. 

� Removing all of the files from a rewritable disc with the Remove button is not the same 
as erasing the disc. When a rewritable disc is erased, nearly all of the space on the 
disc becomes available for a new recording.  

� Clicking on the Remove button does not affect any files on your hard drive. 

Renaming files and folders  
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The files and folders you add to a Data Disc project can be renamed in the project window. Renaming 
files will help you avoid accidentally overwriting older files that have the same names.  

  To rename a file or folder in the file selection window:  

1. Select the file or folder by clicking once on its name. 

2. Press the F2 key on your keyboard. 

3. Type a new name and press the Ent er  key on your keyboard. 

Files are not renamed until after the action button  is clicked and your disc is successfully 
recorded. Renaming files does not affect any files on your hard drive.  

Other topics:  

� Making a data disc 

� Using a disc that already contains data 

� Organizing files in a Data Disc project 

� Making a data disc with the mini-UI 

� Using the Quick Scan panel 
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Making a data disc with the mini-UI  

The Data Disc project is available using the mini-UI.  

  

The mini-UI with the Data Disc project selected  

  To create a data disc using the mini-UI:  

1. If necessary, switch to the miniature user-interface by clicking on the Switch button located in 
the upper right-hand corner of the full-size application window. 

 

  

The Switch button  

The mini-UI is displayed. If the Data Disc project window is already displayed, you can skip 
steps 2 and 3.  
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2. Click on the project icon on the upper left-hand side of the mini-UI to access the project menu. 

3. Click on the Data Disc project icon  . 

4. Insert a disc into a recorder drive and use the Destination Selection menu to select that drive. 

 

  

The mini-UI Destination Selection menu is circled  

5. Drag files from any directory to the portion of the mini-application window that displays the 
message: Drag and drop files here. 

or  

Click on the Add Data button to open a window you can use to add files to your project.  

6. Click the action button  to begin recording data to your disc. 

Other topics:  

� Making a data disc 

� Using a disc that already contains data 

� Organizing files in a Data Disc project 

� Adding and removing data from a Data Disc project 

� Using the Quick Scan panel 
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Using the Quick Scan panel  

The Quick Scan panel is an easy way to add files to your Data Disc projects. Use it to scan a folder or 
drive for the types of files you select. All of the files that are found will be automatically added to your 
project.  

The following categories can be selected from the Quick Scan panel: Email, Financial, Music, Photos, 
Productivity, Video, and My Recorded TV.  

Files will be selected based on the following criteria:  

� Email: All files with the following file name extensions — .pst, .msg, .att, .mbx, .mim, 
.mime, .mlm, .wcm, .dbx, .pfc. 

� Financial: All files with the following file name extensions — .qdb, .qmd, .mn4, .mny, 
.tax, .txf, .qbw. 

� Music: All files with the following file name extensions — .wav, .mp3, .wma, .ogg, .aac, 
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.m4a, .m4p, .wpl, .asx, .m3u. (Your entire My Music folder is included if it is located in 
the the drive or folder you selected to archive.) 

� Photos: All files with the following file name extensions — .jpg, .jpeg, .tif, .tiff, .bmp, 
.gif. (Your entire My Picture folder is included if it is located in the the drive or folder you 
selected to archive.) 

� Productivity: All files with the following file name extensions — .xls, .doc, .ppt, .pps, 
.pdf, .rtf, .mpp, .wps, .wks, .wp, .wpd, .wp6. (Your My Documents folder, with the 
exception of your My Pictures, My Videos, My DVDs, and My Music folders, is included 
if it is located in the the drive or folder you selected to archive.) 

� Video: All files with the following file name extensions — .asf, .avi, .dv, .m1p, .m1v, 
.m2p, .m2v, .mov, .mp2, .mp4, .mpg, .mpeg, .mpv, .qt, .vbs, .wmv, .xtl. (Your My 
Videos folder is included if it is located in the the drive or folder you selected to 
archive.) 

� My Recorded TV: All files with the following file name extensions — .dvr-ms. 

Using the Changed Since calendar  

Use the Changed Since calendar to restrict your scans to files that have changed since a certain date. 
By default, the date is set to the date of your last scan.  

  To set the Changed since calendar:  

1. If necessary, open the Quick Scan panel by clicking on the Quick Scan button. 

2. Click in the Changed Since checkbox until a check mark appears. 

3. Click on the date box arrow to open the calendar. Use the calendar controls to select a date. 

When you click on the Scan button, only files that have changed since that date will be added to 
your Data Disc project.  

 

  

Click on the date box arrow to open the Changed Since calendar  

Note: The project launcher allows you to work on different types of Data projects at the 
same time. However, if you try to scan for files from two Data projects at once, the first 
scan will be put on hold until the second scan is finished.  
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Other topics:  

� Making a data disc 

� Using a disc that already contains data 

� Organizing files in a Data Disc project 

� Adding and removing data from a Data Disc project 

� Making a data disc with the mini-UI 
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Saving a Data Disc project as an image file  

Data Disc projects can be saved as an image file on your hard drive. This image file can be used to 
create CD or DVD discs that contain all the original files. For a more detailed discussion of image files 
and image file types, see Understanding data image files.  

  To save a Data Disc project as an image file:  

1. Open a new or saved Data Disc project  

2. Select the files you wish to include. 

3. Select Browse from the Destination Selection drop-down list. 

A Save As window appears.  

4. Select a destination for the image file and give it a meaningful name. Select a file type from the 
Save as type drop-down list.  

Caution: Images formatted using a CD file type cannot be burned to a DVD. Images 
formatted using a DVD file type cannot be burned to a CD.  

5. Click on the Save button. 

The Save As window closes.  

6. Click on the action button  . 

A progress screen will inform you when the project has been completed.  

7. Click on the Done button to return to the project window.  

Other topics:  

� Data image tips 
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Data image tips  

� Images formatted using a CD file type cannot be burned to a DVD. Images formatted using a 
DVD file type cannot be burned to a CD. 

� The steps described in the "Saving a Data Disc project as an image file" Help topic cannot be 
used to create a bootable disc image. You also cannot use these steps to create an image file 
directly from a CD or DVD. 

� There is no limit on the amount of data you can add to a Data Disc project. This means it is 
possible to create a data image file that contains more data than you will be able to fit on a CD 
or DVD disc. To avoid this potential problem, temporarily select a disc drive from the Destination 
Selection list. Then insert a blank CD or DVD into the drive. You will now be able to use the free 
space indicator in the lower left-hand corner of the application window to monitor the size of your 
project. 

� The default naming convention for image files includes the date of creation and the time of 
creation. 

Other topics:  

� Saving a Data Disc project as an image file 

� Understanding data image files 
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Understanding data image files  

The files in a Data Disc project can be converted into a single file known as an image file. That image file 
can then be used to reproduce the original file set on a CD or DVD disc.  

Image file types  

There are several image file types or formats. Sonic has created a format known as Global-Image. 
Global-Image files contain not only the data files on a disc, but the exact placement of those files, their 
folder structure, read and write properties, and much more. Files in this format can be recognized by 
the .gi file name extension.  

Some mastering products cannot read Global-Image files, however. This could cause a problem if 
someone needed to create a disc from your image and they did not have the necessary Sonic software 
installed on their computer. For this reason, you also have the option to create images of data discs in a 
less complete, but more compatible, format known as ISO. Files in this format can be recognized by 
the .iso file name extension.  

When creating image files, be sure to select a file type that matches the disc format you are planning to 
use. For instance, if you want to create an ISO image and eventually burn it to a DVD disc, select "DVD 
ISO Image (*.iso)" as the file type. If you want to create a Global-Image file and eventually burn it to a CD, 
select "CD Global Image (*.gi)" as the file type.  

Other topics:  

� Saving a Data Disc project as an image file 
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� Data image tips 
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Making a bootable CD or DVD  

The Make Bootable button can be used to create a bootable CD or DVD from a bootable floppy disk or 
from an image file on your hard drive. A bootable CD or DVD can be used to start your computer if your 
operating system becomes damaged. It can also be used to perform maintenance and repair operations 
in DOS.  

For the advanced computer user, bootable discs can provide a level of flexibility and customization not 
available from the recovery discs provided with most modern computers.  

Note: For best results, use boot floppies created by your Windows operating system. The Windows 
Help file explains how to create bootable floppy disks. Boot floppies created using third-party 
software are not supported.  

  To create a bootable CD or DVD:  

1. Click on the Data tab in the project list. 

A list of projects is displayed.  

 

  

Data tab project list  

2. Click on the Data Disc project. 

A Data Disc project opens in the project window.  

 

  

The Data Disc project window  

3. If you have more than one recorder drive, select a drive using the drop-down menu on the 
control panel. 

4. Insert a blank disc into the selected drive. 

5. Click on the Make Bootable button in the data disc toolbar.  
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Make Bootable button  

The Bootable Disc dialog box appears.  

6. To create a bootable CD or DVD from a floppy disk, your computer must have a floppy disk 
drive. Follow these steps: 

a. Insert a bootable floppy disk into your floppy disk drive. 

b. Select Bootable floppy disk in drive A: 

c. Click on the OK button. 

d. An image file is created from the boot floppy and is added to the file selection window. 

7. To create a bootable CD or DVD from an image on your hard drive, follow these steps: 

a. Select Bootable image on hard drive. 

b. Click on the Browse button, and navigate to the image file using the Select Image 
dialog box. When you have selected an image file, click on the Add button. 

c. Click on the OK button to add your selection to the file selection window. 

8. Add additional files to your project, if desired. 

9. If desired, type a name for your disc in the Volume Label text box at the top of the project 
window. 

10. Click on the action button  to begin recording data to your disc. 

Other topics:  

� Tips for creating a bootable CD or DVD 
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Tips for creating a bootable CD or DVD  

Consider the following when creating a bootable CD or DVD:  

� Test your boot floppy before using it to create a bootable CD or DVD. 

� 1.44 MB or 2.88 MB bootable floppy disks are supported. 

� Most modern computers support bootable CDs or DVDs, but many older computers do not. 

� Your computer may need to be told to start from a CD or DVD drive by changing the settings in 
the BIOS setup. Refer to your computer's operating instructions for more information. 

� You can only create bootable CD or DVD discs from blank discs. 

� An emulation format is selected based on the size of the image you select: 

� If the image is 1.44 MB or less, a bootable CD or DVD will be created that your 
computer sees as a 1.44 MB floppy disk. When you start your computer using this 
bootable CD or DVD, the disc will automatically be assigned drive letter A:. 

� If the image is between 1.44 and 2.88 MB, a bootable CD or DVD will be created that 
your computer sees as a 2.88 MB floppy disk. When you start your computer using this 
bootable CD or DVD, the disc will automatically be assigned drive letter A:. 

� If the image is larger than 2.88 MB, a bootable CD or DVD will be created that your 
computer sees as a hard disk partition. When you start your computer using this 
bootable CD or DVD, the disc will automatically be assigned drive letter C:. 
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� When using the image of a disc partition to create a bootable CD or DVD, keep in mind that the 
image must fit on a single disc. 

� When you create a bootable CD or DVD from a floppy disk, an image of that floppy disk is 
stored temporarily on your hard drive with the file name fboot.img. You can use this image to 
create additional boot CDs or DVDs. Keep in mind that this file will be overwritten each time you 
create a bootable CD or DVD from a floppy disk. 

Other topics:  

� Making a bootable CD or DVD 
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Copying files directly to a CD or DVD disc  

The Direct-to-Disc project lets you easily copy files to a CD or DVD disc by simply dragging the files onto 
the project window. Direct-to-Disc uses Sonic's popular Drive Letter Access (DLA) software. When DLA 
version 4.95 or greater is detected on your computer, the Direct-to-Disc project is automatically enabled. 
If DLA is not detected, the project will be replaced with a link to the Sonic eStore, where you can obtain 
information about purchasing Drive Letter Access.  

There are three basic steps when using Direct-to-Disc.  

1. Each CD or DVD disc must be formatted using the Direct-to-Disc formatter before you can begin 
copying files. 

2. Once a disc is formatted, files can be copied by dragging them to the Direct-to-Disc project 
window or by using the standard DLA techniques that may already be familiar to you. 

3. If you would like to share the disc with a friend or use the disc on a computer that does not have 
the Direct-to-Disc project available, the disc must be prepared using a simple process called 
Make Compatible. 

Click on one of the links below to learn more about the Direct-to-Disc project:  

� Starting a Direct-to-Disc project 

� Formatting a blank or rewritable disc 

� Copying files to a disc 

� Using your discs on computers that do not have Direct-to-Disc or DLA installed 

Note: For more information about Drive Letter Access, consult the DLA Help file. It can be opened 
by right-clicking your recorder drive icon in the My Computer directory. Select Properties from the 
shortcut menu. Click on the DLA tab on the Properties window; then click on the link titled Learn 
more about DLA.  
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Starting a Direct-to-Disc project  

1. Click on the Data tab in the project list. 

A list of projects is displayed.  

 

  

Data tab project list  

2. Click on the Direct-to-Disc project. 

A Direct-to-Disc project opens in the project window.  

 

  

The Direct-to-Disc project window  

3. Insert a blank or rewritable CD or DVD into your recorder drive 

or  

Insert a disc that has already been formatted using Drive Letter Access or the Direct-to-Disc 
project.  

Click on one of the links below to continue:  

� Formatting a blank or rewritable disc 

� Copying files to a disc 

� Using your discs on computers that do not have Direct-to-Disc or DLA installed 
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Formatting a blank or rewritable disc  

1. Insert a blank or rewritable disc into your recorder drive. 

2. If necessary, select the drive you are using from the Destination Selection menu. 

3. Click on the Format button on the Direct-to-Disc project window. 

The Format window appears.  

4. Type a name for your disc in the Volume Label text box.  

5. Select either Quick or Full format by clicking beside the option you prefer. 

If you select Quick format or you select Full format and your drive supports background 
formatting, you will be able to use your disc within minutes. If not, you must wait until formatting 
is complete before you can copy files to your disc.  

6. If you have an EasyWrite CD-RW drive, you will have the option to create an EasyWrite disc by 
placing a check mark beside Enable EasyWrite. 

7. Click on the Start button. 

Caution: Formatting a disc makes all previously recorded data inaccessible. Once the Format 
operation is started, it cannot be cancelled.  

Additional notes about formatting:  

� You must have administrative rights to your computer before you can use DLA to format discs 
that have already been formatted. Limited users can only format blank discs. 

� When Full format is selected for a DVD+RW disc that has already been formatted, DLA 
performs a verification step and will attempt to repair any disc errors it finds. This step can take 
20 minutes or more depending on the speed of your drive. 

� Formatting a disc with DLA reduces the amount of space available on the disc. Formatting a 
write-once DVD, for instance, uses about 300 MB of space. 

Comparison of the different types of formatting  

Quick format  Full format  

Faster (generally taking less than 60 seconds)  Depending on the speed of the drive and the 
size of your media, this can take up to 180 
minutes  

Can be performed on all CD and DVD write-once 
discs and on previously formatted rewriteable 
discs.  

Only available for CD-RW and rewriteable DVD 
media  

Must be initially performed for all write-once media  Must be initially performed for all CD-RW and 
rewriteable DVD media  

Will not repair disc errors  Repairs some errors by preventing data from 
being written on damaged sections of the disc  
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Click on one of the links below to continue:  

� Copying files to a disc 

� Using your discs on computers that do not have Direct-to-Disc or DLA installed 

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Copying files to a disc  

� Drag files from any directory window to the Direct-to-Disc project window. The files are copied 
immediately. 

or  

Click on the Add Data button. A window will open that you can use to select files. Click on the 
Add Files button to add the selected files to your disc. The files are copied immediately.  

Tip: The space available on your disc is displayed on the left side of the control panel. To view a list 
of the files on a disc, double-click on the disc icon in your My Computer directory.  

Click on the link below to continue:  

� Using your discs on computers that do not have Direct-to-Disc or DLA installed 
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Using your discs on computers that do not have Direct-to-Disc or DLA 
installed  

If you would like to share the disc with a friend or use the disc on a computer that does not have the 
Direct-to-Disc project available, the disc must be prepared using a simple process called Make 
Compatible.  

1. Insert the disc you want to make compatible into your recorder drive. 

2. Click on the Make Compatible button on the Direct-to-Disc project window. 

3. The Compatibility window appears. 

4. Click on the Start button to make your disc compatible. 

Depending on the amount of data on the disc, this process may take a few minutes to complete 
and cannot be cancelled once it has begun.  

Additional notes about Make Compatible:  

� Make Compatible finalizes your write-once DVD discs. You will not be able to add data to the 
disc once the operation has completed. Do not use this feature unless you are done copying 
files to your write-once disc. 
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� When a disc is closed but not finalized, data can be added to the disc but you will need to run 
Make Compatible again before this new data can be shared with someone who does not have 
DLA installed on their computer. 

� Each Make Compatible operation consumes disc space. The maximum number of times Make 
Compatible can be run on a single CD-R disc is approximately 15. 

Other topics:  

� Starting a Direct-to-Disc project 

� Formatting a blank or rewritable disc 

� Copying files to a disc 
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Using the mini-UI with Direct-to-Disc  

The Direct-to-Disc project is also available using the mini-UI.  

  

The mini-UI with the Direct-to-Disc project selected  

  To drag files directly to a disc using the miniature user-interface:  

Make Compatible and disc formats  

Disc format  Is Make Compatible 
available?  

Can more data be added to the disc after using 
Make Compatible?  

CD-R  Yes  Yes. Discs are closed but not finalized.  

CD-RW  No  Not applicable  

DVD-R  Yes  No. Discs are closed and finalized.  

DVD+R  Yes  No. Discs are closed and finalized.  

DVD 9 (double-
layer)  

Yes  No. Discs are closed and finalized.  

DVD-RW  Yes  Yes. Discs are closed but not finalized.  

DVD+RW  No  Not applicable  

DVD-RAM  No  Not applicable  
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1. If necessary, switch to the miniature user-interface by clicking on the Switch button located in 
the upper right-hand corner of the full-size application window. 

 

  

The Switch button  

The mini-UI is displayed. If the Direct-to-Disc project window is already displayed, you can skip 
steps 2 and 3.  

2. Click on the project icon on the upper left-hand side of the mini-UI to access the project menu. 

3. Click on the Direct-to-Disc project icon  . 

4. Insert a disc into a recorder drive and use the Destination Selection menu to select that drive. 

5. Drag files from any directory to the portion of the mini-application window that displays the 
message: To add data directly to your disc, drag and drop your files here. 
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Data options  

Click on the Options button  on the control panel to open the Options window. Here you will find 
settings that can be used to customize your application.  

Each available group of options is displayed in the left-hand pane. Click on the name of an options group, 
and those option settings will appear on the right.  

Each panel includes a Restore Defaults button that can be used to restore the default settings for the 
options on that panel only.  

Note: Not all options are available for all drives or operating systems.  
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Data options — Data panel  

Use the Data panel to customize the following settings:  

� CD recording options — Choose from the following recording types. (Not all disc recorders 
support all these options.) 

Type:  
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Track-at-Once (TAO) , Open — Tracks are recorded individually. Unless the 
disc is full, additional data can be added to the disc after it is recorded.  

Track-at-Once (TAO), Closed — Tracks are recorded individually. No 
additional data can be added to the disc after it is recorded.  

Disc-at-Once (DAO), Closed — The entire disc is recorded in a single 
session. No additional data can be added to the disc after it is recorded.  

Mode:  

The options include Mode 1 and Mode 2 XA. Mode 1 is used in almost every 
circumstance except advanced format discs such as CD Extra or Video CD. 
Unless you're sure you want to make a Mode 2 disc, it's best to leave this 
setting alone.  

File System:  

The default setting is ISO+Joliet. If you are going to be making a disc that will 
be played back within Windows, you do not need to change this setting.  

File system notes:  

Microsoft Joliet has been used since Windows 95. This system can handle file 
names up to 106 characters.  

Choose ISO+Joliet to make a disc readable by as many computers as 
possible.  

Use ISO Level 2 only if you are familiar with this file system type.  

The DVD file system is preset to ISO+Joliet+UDF. It cannot be changed.  

� Write-Once DVD Compatibility — Before recording to a write-once DVD disc, you should 
consider whether you want the disc left "open" (appendable) or "closed" (nonappendable) at the 
end of a recording session.  

� To leave your disc open, choose the option that reads: " I would like to use discs for 
more than one recording."  You will be able to record multiple times to a single disc, 
but fewer drives will be able to read the disc. This is a good choice if you expect to 
make many, small recordings on high-capacity DVD discs or don't need to share your 
discs. 

� To close your disc at the end of a recording, choose the option that reads: " I only need 
to use discs for one recording."  You will only be able to record to the disc once, but 
the disc will be compatible with a larger number of drives. This is a good choice if you 
typically fill your discs during a single recording session or need to use a disc on more 
than one computer. 
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Data options — Verify data before burning  

The following additional option is included with your version of this plug-in:  
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� Verify data written to the disc after burning — A check mark in this box adds a verification 
step to ensure no errors occured during the recording of your data discs. 
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Data options — Advanced panel  

Use the Advanced panel to customize the following settings:  

� Volume Descriptor: 

Publisher ID — Type your name/company name, etc. in this text box (optional).  

Data Preparer — Type your name/company name, etc. in this text box (optional).  

Application ID — Type your Application ID, etc. in this text box (optional).  

� File Date and Time — Windows keeps track of the dates and times your files are created and 
modified. By adjusting this option, you can burn files with their original file dates and times or 
with the date and time they were recorded (mastered). 

� Enable disc spanning for data discs — Data Disc projects can be spread across more than 
one disc when this option is selected. As files are added to the project, the number of discs 
required is displayed on the right side of the control panel.  

This additional information will be useful when creating Data Disc projects that span more than 
one disc:  

� All of the discs in a project must be the same general format — DVD or CD. 

� In a multi-disc project, files are assigned based on the size of the first disc you use. If 
your first disc has a capacity of 650 MB, for example, no more than 650 MB will be 
burned on any subsequent disc, even if it has a larger capacity. This also means that 
no disc in a project can have a smaller capacity than the first disc used in a project. 

� A single file cannot be copied across more than one disc. 

� Discs used in a multi-disc project are closed once they are recorded. If you used write-
once discs, you will not be able to add additional data.  

� An HTML file is placed on each disc listing its contents. 

� Automatically load appendable discs — When this option is selected, a message box 
appears whenever an appendable disc is detected in the destination drive for a Data Disc 
project. The message box asks if you would like to load the files already on the disc into the 
current project. 

Loading the disc is necessary if you wish to add new files to a rewritable disc without first 
erasing the existing files. Loading the disc is always required to add files to an appendable write-
once disc that already contains files.  

When this option is not selected, files from an appendable disc can still be loaded using the 
Load Disc button.  
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Video projects  
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All video projects are grouped under the Video tab.  

  To open a new Video project:  

1. Click on the Video tab in the project list. 

A list of projects is displayed.  

 

  

Video tab  

2. Click on a project title to start a new project in the Project Window. 

or  

Click on Video Guide to learn more about each available project.  

Other topics:  

� Watching a movie with CinePlayer 

� Upgrading your video software 
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Making a video disc with MyDVD  

The Create Project project opens the main application window of MyDVD with the correct project format 
automatically selected. In MyDVD, you can create a project using video, audio, and images and then burn 
it onto a disc.  

  To create a video disc with MyDVD:  

1. Click on the Video tab in the project list. 

A list of projects is displayed.  

2. Click on the Create Project project. 

 

  

Video tab project list  

3. One or more disc formatting options appear in the project window. Select a format by clicking on 
its description. 

4. The MyDVD application window opens with the correct project format automatically selected. 
The project launcher is minimized on the Windows taskbar. 

���
����	
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To learn more about using MyDVD, click on the Help button on the MyDVD application window.  

To return to the project launcher, close MyDVD or click on the launcher in the Windows taskbar.  

Other topics:  

� Editing a video disc with MyDVD 

� Opening a saved MyDVD project 
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Editing a video disc with MyDVD  

After you burn a DVD or VCD, you may want to add, edit, or remove material, organize the disc 
differently, change the menu design, or just burn more copies. You can do all of this with any disc created 
by MyDVD or by other Sonic AuthorScript-enabled applications, such as Sonic PrimeTime.  

If you edit a rewritable (RW) disc, you can burn the edited project back onto the original disc. If you edit a 
recordable (R) disc, you must burn the edited project onto a new disc.  

  To edit a video disc with MyDVD:  

1. Click on the Video tab in the project list. 

A list of projects is displayed.  

2. Click on the Edit Disc project. 

 

  

Video tab project list  

3. In the project window, click on Edit an Existing Disc. 

4. The MyDVD application window opens, and a Browse for Folder window is displayed. Browse to 
the disc you want to edit, and click on the OK button. 

5. Use the Sonic Disc Browser window to select titles to import into MyDVD. 

6. Click on the Import button. 

To learn more about using MyDVD, click on the Help button on the MyDVD application window.  

To return to the project launcher, close MyDVD or click on the launcher in the Windows taskbar.  

Other topics:  

� Making a video disc with MyDVD 

� Opening a saved MyDVD project 
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Opening a saved MyDVD project  

  To open a MyDVD project from the project launcher:  

1. Click on the Video tab in the project list. 

A list of projects is displayed.  

2. Click on the Create Project project. 

 

  

Video tab project list  

3. Click on the DVD project description in the project window. 

4. The MyDVD application window opens. The project launcher is minimized on the Windows 
taskbar. 

5. Choose File > Open in MyDVD. 

6. Navigate to the saved project you wish to open. 

Other topics:  

� Making a video disc with MyDVD 

� Editing a video disc with MyDVD 
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Watching a movie with CinePlayer  

The Watch Movie project starts Sonic CinePlayer if this video playback program is detected on your 
computer. CinePlayer can be used to watch DVD and Video CD movies. If CinePlayer is not detected on 
your computer, this project will not appear in your project list. Instead, you may see an Upgrade link in the 
Video Guide. Click on this link to learn more about purchasing CinePlayer.  

  To watch a video with Sonic CinePlayer:  

1. Click on the Video tab in the project list. 

A list of projects is displayed.  

2. Click on the Watch Movie project. 
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Video tab project list  

3. In the project window, click on Watch DVD Movie. 

4. CinePlayer opens, and the project launcher is minimized on the Windows taskbar. 

CinePlayer can play video discs and video files on your hard drive. To learn more about using 
CinePlayer, press F1 on your keyboard while the CinePlayer is active. The CinePlayer Help file will open.  

Other topics:  

� Upgrading your video software 
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Upgrading your video software  

Sonic software is often available in more than one version. If your version of a program does not support 
a particular project, an upgrade offer may be displayed in the Video Guide. If you have an Internet 
connection, clicking on an upgrade offer will connect you with the Sonic eStore where you can upgrade 
your video software. (The Sonic eStore can be accessed at www.sonic.com.)  

Other topics:  

� Watching a movie with CinePlayer 

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

Tools  

The Tools tab always appears as the last tab in the project list. It contains a variety of useful disc 
projects.  
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The Tools tab and project list  

Click on any of the topics below to learn more:  

� Erase Disc 

� Finalize Disc 

� Disc Information 

� Label Disc 

Note: The list of projects may vary depending on your version of the application and the project 
modules installed on your computer.  
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Erase Disc  

Use the Erase Disc project to erase a re-writable disc.  

  To erase a rewritable disc:  

1. Click on the Tools tab in the project list. 

A list of projects is displayed.  

2. Click on the Erase Disc project. 

3. Follow the instructions in the main project window to erase your disc. 

Should I choose Quick Erase or Full Erase?  

� Quick Erase erases the disc's table of contents, which makes the data on the 
disc inaccessible. However, it does not actually erase the data. Quick Erase 
usually takes less than one minute. 

� Full Erase erases all of the data on the disc. Depending on the speed of the 
drive and the disc type, Full Erase can take 30 minutes or more. 

Tip: Once a disc is erased, the data that was on it cannot be recovered. You may wish to review the 
contents of your discs before erasing them.  
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Finalize Disc  

The Finalize Disc project closes a disc to ensure it is compatible with the largest number of drives and 
music players. When a write-once disc is closed, no new data or music can be added to it. When a 
rewritable disc is closed, no new data or music can be added to it unless the disc is erased.  
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  To finalize a disc:  

1. Click on the Tools tab in the project list. 

A list of projects is displayed.  

2. Click on the Finalize Disc project. 

3. Follow the instructions in the main project window to finalize the disc. 

Note: Audio CDs are automatically finalized after they are recorded.  

Other topics:  

� Using double-layer discs 
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Disc Information  

The Disc Information project assembles information about your disc drive, the disc in the drive, and the 
data on the disc. When you click on the Disc Information project on the Tools tab, this information is 
presented in the project window.  

  To view disc and drive information using the Disc Information project:  

1. Insert a disc into your disc drive. 

2. Select that drive from the drive drop-down list on the control panel. 

The disc in the drive is analyzed and the following information is displayed:  

� Drive properties, including drive type, firmware information, and supported disc formats. 

� Disc properties, including disc type, number of tracks (or zones on a DVD disc) 
recorded, space available, and other information. 

� Data properties, including the track type and position, track lengths, pre-gaps, and 
other information. 

Tip: The Disc Information project window displays pre-gaps for audio discs if the Show pre-gaps 
on audio CDs checkbox is selected. The checkbox is located at the bottom of the Disc Information 
project window. Selecting this option may slow the display of your disc information. (A pre-gap is the 
period of silence that typically occurs between each track on an audio CD.)  
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Label Disc  
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Some versions of this application include disc labeling software that allows you to create personalized 
labels for your discs. You can start this program in any of several ways:  

� Click on the Tools tab and select the Label Disc project. 

or  

� Choose Label Disc from the Tools menu. 

or  

� Click on the Label Disc button when it appears in the main project window at the conclusion of 
many disc recording projects.  

File information from the latest project will be shared with the disc labeling program.  

Note: The Label Disc project and Label Disc button will not appear if the disc labeling software is 
not detected on your computer.  
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Legal Information  

To review restrictions on the use of this product, click on the links below:  

� End User License Agreement 

� GNU Library General Public License 
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End User License Agreement  

SONIC SOLUTIONS  

END-USER LICENSE AGREEMENT  

THIS IS A CONTRACT, PLEASE READ IT CAREFULLY, BY INSTALLING THIS SOFTWARE YOU 
ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT, YOU WILL NOT BE ABLE TO 
USE THIS SOFTWARE UNLESS YOU ACCEPT THIS AGREEMENT. BY USING THE SOFTWARE, 
YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE 
TO ANY TERM OR CONDITION, YOU MAY NOT INSTALL OR RUN THIS SOFTWARE.  

1. License. Sonic Solutions, a California corporation, ("Sonic") hereby grants to the purchaser (hereafter 
"you") a personal, non-exclusive, non-transferable license (the "License"), without the right to sublicense, 
to use the application, installation, utility, system, upgrade or other software accompanying this License, 
whether on disk, in read only memory, or on any other media (the "Sonic Software"), the related 
documentation and materials. The Sonic Software is licensed for use in object code form only, for your 
internal use and only on a specific hardware system. The Sonic Software is licensed, not sold, to you by 
Sonic. You own the media on which the Sonic Software is recorded but Sonic and/or Sonic's licensor(s) 
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retain title to the Sonic Software and to any copies which this License authorizes you to make.You 
acknowledge that Sonic and/or Sonic's licensor(s) (hereafter, collectively referred to as "Sonic") retain all 
other ownership rights connected with the Software, including, without limitation, all copyrights, trademark 
rights, and all other intellectual property rights. You agree to refrain from any action which would diminish 
such rights or would call them into question. You agree that this License shall apply to any software 
provided to you by Sonic or Sonic's representative as replacement or upgrade software to substitute for 
or to be used in conjunction with the software accompanying this License.  

2. Permitted Uses and Restrictions. This License allows you to install and use the Sonic Software on a 
single Sonic-manufactured or Sonic-approved hardware system at a time. This License does not allow 
the Sonic Software to exist on more than one hardware system at a time. You may make one copy of the 
Sonic Software in machine-readable form for backup purposes only. The backup copy must include all 
copyright notices and any other proprietary legends contained on the original copy of the Sonic Software. 
You may use the Sonic Software in a networked environment and transmit the Sonic Software from one 
hardware system to another over a network so long as each hardware system which receives the Sonic 
Software is the subject of a license for the Sonic Software it receives. Except as permitted by applicable 
law and this License, you may not decompile, reverse engineer, disassemble, modify, rent, lease, loan, 
distribute, create derivative works from the Sonic Software or publish or transmit the Sonic Software over 
a network. You may, however, transfer your rights under this License, provided you transfer the related 
documentation, this License, and a copy of the Sonic Software to a party who agrees to accept the terms 
of this License and destroy any other copies of the Sonic Software in your possession. Your rights under 
this License will terminate automatically without notice from Sonic if you fail to comply with any term(s) of 
this License.  

3. Limited Warranty on Media. Sonic warrants the media on which the Sonic Software is delivered to be 
free from defects in materials and workmanship under normal use for a period of ninety (90) days from 
the date of original purchase. Your exclusive remedy under this paragraph shall be, at Sonic's option, a 
refund of the purchase price of the product containing the Sonic Software or replacement of the Sonic 
Software which is returned to Sonic or an Sonic authorized representative.  

THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA INCLUDING THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE. 
SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY 
LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU. THE LIMITED WARRANTY SET FORTH 
HEREIN IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER ORAL OR WRITTEN, EXPRESS, 
OR IMPLIED. SONIC SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES. THIS LIMITED 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY BY JURISDICTION.  

4. Disclaimer of Warranty on Sonic Software. You expressly acknowledge and agree that use of the 
Sonic Software is at your sole risk. The Sonic Software is provided "AS IS" and without warranty of any 
kind and Sonic  

EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE WITH RESPECT TO THE SONIC SOFTWARE. SONIC DOES NOT 
WARRANT THAT THE FUNCTIONS CONTAINED IN THE SONIC SOFTWARE WILL MEET YOUR 
REQUIREMENTS, OR THAT THE OPERATION OF THE SONIC SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SONIC SOFTWARE WILL BE 
CORRECTED. FURTHERMORE, SONIC DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE SONIC SOFTWARE OR RELATED 
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY SONIC OR AN SONIC 
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE 
SCOPE OF THIS WARRANTY. SHOULD THE SONIC SOFTWARE PROVE DEFECTIVE, YOU (AND 
NOT SONIC OR AN SONIC AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.  
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5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SONIC BE 
LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF OR RELATING TO THIS LICENSE. SOME JURISDICTIONS DO NOT ALLOW THE 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THIS LIMITATION MAY NOT 
APPLY TO YOU. In no event shall Sonic's total liability to you for all damages exceed the amount paid for 
this to the Sonic Software.  

6. Export Law Restrictions. You agree that the Sonic Software will not be exported outside the United 
States except as authorized by United States law. You also agree that Sonic Software that has been 
rightfully obtained outside of the United States shall not be exported except as authorized by the laws of 
the United States and of the jurisdiction in which the Sonic Software was obtained.  

7. Controlling Law and Severability. This License shall be governed by the laws of the United States and 
the State of California. If for any reason a court of competent jurisdiction finds any provision, or portion 
thereof, to be unenforceable, the remainder of this License shall continue in full force and effect.  

8. Complete Agreement. This License constitutes the entire agreement between the parties with respect 
to the use of the Sonic Software and supersedes all prior or contemporaneous understandings regarding 
such subject matter. No amendment to or modification of this License will be binding unless in writing and 
signed by Sonic.  

9. Digital Rights Management. Content providers are using the Microsoft digital rights management 
technology for Windows Media distributed with this software ("WM-DRM") to protect the integrity of their 
content ("Secure Content") so that their intellectual property, including copyright, in such content is not 
misappropriated. Portions of this software and other 3rd party applications use WM-DRM to play Secure 
Content ("WM-DRM Software"). If the WM-DRM Software's security has been compromised, owners of 
Secure Content ("Secure Content Owners") may request that Microsoft revoke the WM-DRM Software's 
right to copy, display and/or play Secure Content. Revocation does not alter the WM-DRM Software's 
ability to play unprotected content. A list of revoked WM-DRM Software is sent to your computer 
whenever you download a license for Secure Content from the Internet. Microsoft may, in conjunction 
with such license, also download revocation lists onto your computer on behalf of Secure Content 
Owners. Secure Content Owners may also require you to upgrade some of the WM-DRM components 
distributed with this software ("WM-DRM Upgrades") before accessing their content. When you attempt to 
play such content, WM-DRM Software built by Microsoft will notify you that a WM-DRM Upgrade is 
required and then ask for your consent before the WMDRM Upgrade is downloaded. Non-Microsoft WM-
DRM Software may do the same. If you decline the upgrade, you will not be able to access content that 
requires the WM-DRM Upgrade; however, you will still be able to access unprotected content and Secure 
Content that does not require the upgrade. WM-DRM features that access the Internet, such as acquiring 
new licenses and/or performing a required WM-DRM Upgrade, can be switched off. When these features 
are switched off, you will still be able to play Secure Content if you have a valid license for such content 
already stored on your computer.  

© 2000-2005 Sonic Solutions. All Rights Reserved. 

 

GNU Library General Public License  

Version 2, June 1991  

Copyright (C) 1991 Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 
USA.  

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is 
not allowed. (This is the first released version of the library GPL. It is numbered 2 because it goes with 
version 2 of the ordinary GPL.)  
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Preamble  

The licenses for most software are designed to take away your freedom to share and change it. By 
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change 
free software--to make sure the software is free for all its users.  

This license, the Library General Public License, applies to some specially designated Free Software 
Foundation software, and to any other libraries whose authors decide to use it. You can use it for your 
libraries, too.  

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are 
designed to make sure that you have the freedom to distribute copies of free software (and charge for this 
service if you wish), that you receive source code or can get it if you want it, that you can change the 
software or use pieces of it in new free programs; and that you know you can do these things.  

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask 
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute 
copies of the library, or if you modify it.  

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients 
all the rights that we gave you. You must make sure that they, too, receive or can get the source code. If 
you link a program with the library, you must provide complete object files to the recipients so that they 
can relink them with the library, after making changes to the library and recompiling it. And you must 
show them these terms so they know their rights.  

Our method of protecting your rights has two steps: (1) copyright the library, and (2) offer you this license 
which gives you legal permission to copy, distribute and/or modify the library.  

Also, for each distributor's protection, we want to make certain that everyone understands that there is no 
warranty for this free library. If the library is modified by someone else and passed on, we want its 
recipients to know that what they have is not the original version, so that any problems introduced by 
others will not reflect on the original authors' reputations.  

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that 
companies distributing free software will individually obtain patent licenses, thus in effect transforming the 
program into proprietary software. To prevent this, we have made it clear that any patent must be 
licensed for everyone's free use or not licensed at all.  

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License, 
which was designed for utility programs. This license, the GNU Library General Public License, applies to 
certain designated libraries. This license is quite different from the ordinary one; be sure to read it in full, 
and don't assume that anything in it is the same as in the ordinary license.  

The reason we have a separate public license for some libraries is that they blur the distinction we usually 
make between modifying or adding to a program and simply using it. Linking a program with a library, 
without changing the library, is in some sense simply using the library, and is analogous to running a 
utility program or application program. However, in a textual and legal sense, the linked executable is a 
combined work, a derivative of the original library, and the ordinary General Public License treats it as 
such.  

Because of this blurred distinction, using the ordinary General Public License for libraries did not 
effectively promote software sharing, because most developers did not use the libraries. We concluded 
that weaker conditions might promote sharing better.  

However, unrestricted linking of non-free programs would deprive the users of those programs of all 
benefit from the free status of the libraries themselves. This Library General Public License is intended to 
permit developers of non-free programs to use free libraries, while preserving your freedom as a user of 
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such programs to change the free libraries that are incorporated in them. (We have not seen how to 
achieve this as regards changes in header files, but we have achieved it as regards changes in the actual 
functions of the Library.) The hope is that this will lead to faster development of free libraries.  

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to 
the difference between a "work based on the library" and a "work that uses the library." The former 
contains code derived from the library, while the latter only works together with the library.  

Note that it is possible for a library to be covered by the ordinary General Public License rather than by 
this special one.  

GNU Library General Public License Terms and Conditions for Copying, 
Distribution, and Modification  

0. This License Agreement applies to any software library which contains a notice placed by the copyright 
holder or other authorized party saying it may be distributed under the terms of this Library General 
Public License (also called "this License"). Each licensee is addressed as "you."  

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked 
with application programs (which use some of those functions and data) to form executables.  

The "Library," below, refers to any such software library or work which has been distributed under these 
terms. A "work based on the Library" means either the Library or any derivative work under copyright law: 
that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or 
translated straightforwardly into another language. (Hereinafter, translation is included without limitation in 
the term "modification.")  

"Source code" for a work means the preferred form of the work for making modifications to it. For a 
library, complete source code means all the source code for all modules it contains, plus any associated 
interface definition files, plus the scripts used to control compilation and installation of the library.  

Activities other than copying, distribution and modification are not covered by this License; they are 
outside its scope. The act of running a program using the Library is not restricted, and output from such a 
program is covered only if its contents constitute a work based on the Library (independent of the use of 
the Library in a tool for writing it). Whether that is true depends on what the Library does and what the 
program that uses the Library does.  

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in 
any medium, provided that you conspicuously and appropriately publish on each copy an appropriate 
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the 
absence of any warranty; and distribute a copy of this License along with the Library.  

You may charge a fee for the physical act of transferring a copy, and you may at your option offer 
warranty protection in exchange for a fee.  

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on 
the Library, and copy and distribute such modifications or work under the terms of Section 1 above, 
provided that you also meet all of these conditions:  

a) The modified work must itself be a software library.  

b) You must cause the files modified to carry prominent notices stating that you changed the files and the 
date of any change.  

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of 
this License.  

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application 
program that uses the facility, other than as an argument passed when the facility is invoked, then you 

Page 90 of 95Getting Started

6/29/2006file://C:\Documents and Settings\dpsuser\Local Settings\Temp\~hh412D.htm



must make a good faith effort to ensure that, in the event an application does not supply such function or 
table, the facility still operates, and performs whatever part of its purpose remains meaningful.  

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined 
independent of the application. Therefore, Subsection 2d requires that any application-supplied function 
or table used by this function must be optional: if the application does not supply it, the square root 
function must still compute square roots.)  

These requirements apply to the modified work as a whole. If identifiable sections of that work are not 
derived from the Library, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them as 
separate works. But when you distribute the same sections as part of a whole which is a work based on 
the Library, the distribution of the whole must be on the terms of this License, whose permissions for 
other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.  

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; 
rather, the intent is to exercise the right to control the distribution of derivative or collective works based 
on the Library.  

In addition, mere aggregation of another work not based on the Library with the Library (or with a work 
based on the Library) on a volume of a storage or distribution medium does not bring the other work 
under the scope of this License.  

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to 
a given copy of the Library. To do this, you must alter all the notices that refer to this License, so that they 
refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer 
version than version 2 of the ordinary GNU General Public License has appeared, then you can specify 
that version instead if you wish.) Do not make any other change in these notices.  

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General 
Public License applies to all subsequent copies and derivative works made from that copy.  

This option is useful when you wish to copy part of the code of the Library into a program that is not a 
library.  

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code 
or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the 
complete corresponding machine-readable source code, which must be distributed under the terms of 
Sections 1 and 2 above on a medium customarily used for software interchange.  

If distribution of object code is made by offering access to copy from a designated place, then offering 
equivalent access to copy the source code from the same place satisfies the requirement to distribute the 
source code, even though third parties are not compelled to copy the source along with the object code.  

5. A program that contains no derivative of any portion of the Library, but is designed to work with the 
Library by being compiled or linked with it, is called a "work that uses the Library." Such a work, in 
isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.  

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative 
of the Library (because it contains portions of the Library), rather than a "work that uses the library." The 
executable is therefore covered by this License. Section 6 states terms for distribution of such 
executables.  

When a "work that uses the Library" uses material from a header file that is part of the Library, the object 
code for the work may be a derivative work of the Library even though the source code is not. Whether 
this is true is especially significant if the work can be linked without the Library, or if the work is itself a 
library. The threshold for this to be true is not precisely defined by law.  
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If such an object file uses only numerical parameters, data structure layouts and accessors, and small 
macros and small inline functions (ten lines or less in length), then the use of the object file is 
unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code 
plus portions of the Library will still fall under Section 6.)  

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under 
the terms of Section 6. Any executables containing that work also fall under Section 6, whether or not 
they are linked directly with the Library itself.  

6. As an exception to the Sections above, you may also compile or link a "work that uses the Library" with 
the Library to produce a work containing portions of the Library, and distribute that work under terms of 
your choice, provided that the terms permit modification of the work for the customer's own use and 
reverse engineering for debugging such modifications.  

You must give prominent notice with each copy of the work that the Library is used in it and that the 
Library and its use are covered by this License. You must supply a copy of this License. If the work during 
execution displays copyright notices, you must include the copyright notice for the Library among them, 
as well as a reference directing the user to the copy of this License. Also, you must do one of these 
things:  

a) Accompany the work with the complete corresponding machine-readable source code for the Library 
including whatever changes were used in the work (which must be distributed under Sections 1 and 2 
above); and, if the work is an executable linked with the Library, with the complete machine-readable 
"work that uses the Library," as object code and/or source code, so that the user can modify the Library 
and then relink to produce a modified executable containing the modified Library. (It is understood that 
the user who changes the contents of definitions files in the Library will not necessarily be able to 
recompile the application to use the modified definitions.)  

b) Accompany the work with a written offer, valid for at least three years, to give the same user the 
materials specified in Subsection 6a, above, for a charge no more than the cost of performing this 
distribution.  

c) If distribution of the work is made by offering access to copy from a designated place, offer equivalent 
access to copy the above specified materials from the same place.  

d) Verify that the user has already received a copy of these materials or that you have already sent this 
user a copy.  

For an executable, the required form of the "work that uses the Library" must include any data and utility 
programs needed for reproducing the executable from it. However, as a special exception, the source 
code distributed need not include anything that is normally distributed (in either source or binary form) 
with the major components (compiler, kernel, and so on) of the operating system on which the executable 
runs, unless that component itself accompanies the executable.  

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that 
do not normally accompany the operating system. Such a contradiction means you cannot use both them 
and the Library together in an executable that you distribute.  

7. You may place library facilities that are a work based on the Library side-by-side in a single library 
together with other library facilities not covered by this License, and distribute such a combined library, 
provided that the separate distribution of the work based on the Library and of the other library facilities is 
otherwise permitted, and provided that you do these two things:  

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with 
any other library facilities. This must be distributed under the terms of the Sections above.  

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, 
and explaining where to find the accompanying uncombined form of the same work.  

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided 
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under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library 
is void, and will automatically terminate your rights under this License. However, parties who have 
received copies, or rights, from you under this License will not have their licenses terminated so long as 
such parties remain in full compliance.  

9. You are not required to accept this License, since you have not signed it. However, nothing else grants 
you permission to modify or distribute the Library or its derivative works. These actions are prohibited by 
law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work 
based on the Library), you indicate your acceptance of this License to do so, and all its terms and 
conditions for copying, distributing or modifying the Library or works based on it.  

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically 
receives a license from the original licensor to copy, distribute, link with or modify the Library subject to 
these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the 
rights granted herein. You are not responsible for enforcing compliance by third parties to this License.  

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason 
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or 
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of 
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License 
and any other pertinent obligations, then as a consequence you may not distribute the Library at all. For 
example, if a patent license would not permit royalty-free redistribution of the Library by all those who 
receive copies directly or indirectly through you, then the only way you could satisfy both it and this 
License would be to refrain entirely from distribution of the Library.  

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply, and the section as a whole is intended to apply in other 
circumstances.  

It is not the purpose of this section to induce you to infringe any patents or other property right claims or 
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the 
free software distribution system which is implemented by public license practices. Many people have 
made generous contributions to the wide range of software distributed through that system in reliance on 
consistent application of that system; it is up to the author/donor to decide if he or she is willing to 
distribute software through any other system and a licensee cannot impose that choice.  

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this 
License.  

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by 
copyrighted interfaces, the original copyright holder who places the Library under this License may add 
an explicit geographical distribution limitation excluding those countries, so that distribution is permitted 
only in or among countries not thus excluded. In such case, this License incorporates the limitation as if 
written in the body of this License.  

13. The Free Software Foundation may publish revised and/or new versions of the Library General Public 
License from time to time. Such new versions will be similar in spirit to the present version, but may differ 
in detail to address new problems or concerns.  

Each version is given a distinguishing version number. If the Library specifies a version number of this 
License which applies to it and "any later version," you have the option of following the terms and 
conditions either of that version or of any later version published by the Free Software Foundation. If the 
Library does not specify a license version number, you may choose any version ever published by the 
Free Software Foundation.  

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions 
are incompatible with these, write to the author to ask for permission. For software which is copyrighted 
by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions 
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for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our 
free software and of promoting the sharing and reuse of software generally.  

NO WARRANTY  

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE 
LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE 
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
LIBRARY "AS IS"WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, 
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.  

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL 
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE 
THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY 
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE 
OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA 
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER 
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

END OF TERMS AND CONDITIONS  

How to Apply These Terms to Your New Libraries  

If you develop a new library, and you want it to be of the greatest possible use to the public, we 
recommend making it free software that everyone can redistribute and change. You can do so by 
permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General 
Public License).  

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of 
each source file to most effectively convey the exclusion of warranty; and each file should have at least 
the "copyright" line and a pointer to where the full notice is found.  

<one line to give the library's name and a brief idea of what it does.>  

Copyright (C) <year> <name of author>  

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Library 
General Public License as published by the Free Software Foundation; either version 2 of the License, or 
(at your option) any later version.  

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even 
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the 
GNU Library General Public License for more details.  

You should have received a copy of the GNU Library General Public License along with this library; if not, 
write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307 USA.  

Also add information on how to contact you by electronic and paper mail. You should also get your 
employer (if you work as a programmer) or your school, if any, to sign a "copyright disclaimer" for the 
library, if necessary. Here is a sample; alter the names:  

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs) 
written by James Random Hacker.  

<signature of Ty Coon>, 1 April 1990  

Ty Coon, President of Vice  
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That's all there is to it!  

© 2000-2005 Sonic Solutions. All Rights Reserved. 
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